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Présentation de VesselView 4
IMPORTANT :  VesselView est un affichage multifonction (MFD) compatible avec les produits fabriqués par Mercury
Marine Outboards, Mercury MerCruiser et Mercury Diesel. Certaines des fonctions décrites dans ce manuel seront
désactivées en fonction de l'ensemble de propulsion auquel VesselView est connecté.
VesselView 4 est un centre complet d’informations sur le bateau complet qui peut afficher des données sur deux moteurs à
essence ou diesel au maximum. Il contrôle et affiche continuellement des données de fonctionnement comprenant des
informations détaillées sur la température et la profondeur de l'eau, l'état du trim, la vitesse du bateau et l'angle de
direction, ainsi que l'état des réservoirs de carburant, d'huile, d'eau propre et d'eau usée.
VesselView peut en outre être totalement intégré à un système mondial de localisation (GPS) du bateau ou à d'autres
dispositifs compatibles NMEA pour fournir des informations instantanées sur la navigation, la vitesse et le carburant
nécessaire pour parvenir à destination.
VesselView est un affichage supplémentaire destiné aux fonctions du pilote automatique et de la manette. Toutes les
fonctionnalités de pilotage sont contrôlées par le biais du pavé CAN de pilotage automatique de Mercury Marine.
VesselView affiche l'état actif ou en veille d'un mode de commande ; des fenêtres contextuelles s'affichent lorsque le
bateau atteint des points de cheminement, sollicitant une réponse pour changer de cap. Un texte d'affichage
supplémentaire peut être utilisé pour régler les moteurs et les embases afin d'obtenir une efficacité maximale.
VesselView est équipé d'un port de lecture de carte microSD permettant à un équipementier ou à un revendeur autorisé
d'importer la configuration de personnalité du bateau. Le propriétaire du bateau peut également l'utiliser pour mettre à
niveau le logiciel. Dans le cas où plusieurs VesselView seraient utilisés, dans le cadre d'une application à trois ou quatre
moteurs, ou en tant que deuxième barre, la même carte microSD peut être utilisée pour le téléchargement de ces
configurations.

Boutons

VesselView 4
a - Bouton PAGES
b - Flèche GAUCHE
c - Flèche DROITE
d - Bouton ENTER (Entrée)

• Une pression sur le bouton PAGES permet d'activer le menu de la barre de défilement. Une deuxième pression sur le
bouton PAGES permet de quitter le menu de la barre de défilement.

• Les flèches GAUCHE et DROITE permettent de parcourir (mettre en surbrillance) les champs d'un écran.
• Appuyer sur le bouton ENTER (Entrée) une fois l'icône souhaitée mise en surbrillance afin d'accéder à ce champ de

données ou à cette fonction.

a
b

d
51534

c
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Panneau arrière

a

b

55835

Élément Fonction Description
a NMEA 2000 Raccordement au réseau NMEA 2000

b SmartCraft Entrée d'alimentation et raccordement au réseau SmartCraft, liaison aux
instruments SC 100

Emplacements et descriptions de l'écran VesselView 4
VesselView comporte plusieurs champs affichant des informations spécifiques relatives au moteur et aux modes actifs.

51378

1 3

4

5

6

78910

11

2

1. Volts ou depth (Profondeur) : Ce champ de données peut être configuré par l'utilisateur. Une liste du contenu affiché
disponible peut être modifiée dans le menu Settings (Paramètres).
• Volts ne s'affiche dans le champ que lorsqu'un transducteur de profondeur est installé.
• Si aucun transducteur de profondeur n'est installé ou si celui-ci a été retiré, Depth (Profondeur) est remplacé par

Volts.
2. Fuel (Carburant) : Ce champ de données peut être configuré par l'utilisateur. Une liste du contenu affiché disponible

peut être modifiée dans le menu Settings (Paramètres).
• Affiche uniquement le volume total de carburant. Les données relatives au carburant figurent à l'écran, sous Fuel

Management (Gestion du carburant).
3. Angle de direction : Si l'option est installée, l'utilisateur peut sélectionner des limites maximales de 45 ou 60° et

inverser l'angle. L'angle de direction est disponible si le capteur est installé et surveillé par le module de commande.
Cette fonctionnalité est désactivée lorsque l'ensemble de propulsion installé est un moteur hors-bord, mais elle peut
être manuellement activée dans le menu Settings (Paramètres).

4. RPM (Régime moteur) : Affiche une barre mobile représentant le régime moteur. Dans le cas d'une application à
moteurs jumelés, deux barres mobiles distinctes s'affichent.

5. Speed (Vitesse) : Affiche la vitesse du bateau. L'écran affiche deux tirets si aucune source de vitesse n'est disponible.
L'affichage indique la valeur de vitesse, la source de la vitesse (roue à aubes, Pitot ou GPS) et les unités de mesure
(mi/h est l'unité par défaut). Les valeurs de vitesse comportant plus de deux chiffres entiers s'affichent dans un format
plus petit.

6. Position du pignon : Les produits DTS indiquent toutes les positions du pignon de chaque moteur. Les positions sont
définies comme suit : F (marche avant), N (point mort) et R (marche arrière) Les produits non DTS indiquent N (point
mort) et G (en prise).
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7. Trim : Ce champ de données peut être configuré par l'utilisateur. Affiche le trim d'un ou de deux moteurs. Une fenêtre
contextuelle de trim est disponible dans la zone de données contextuelles. La fenêtre contextuelle peut être activée ou
désactivée dans le menu Settings (Paramètres).

8. Tabs (Dérives) : Ce champ de données peut être configuré par l'utilisateur. Une liste du contenu affiché disponible
peut être modifiée dans le menu Settings (Paramètres).
• Le cas échant, la dérive bâbord est affichée sur le côté gauche des données de trim et la dérive tribord est

affichée sur le côté droit des données de trim.
9. Icône de barre de défilement : Affiche une icône représentant les données actuellement affichées dans la zone des

données sélectionnées de l'écran. Appuyer sur le bouton PAGES pour ouvrir la barre de défilement. L'utilisateur peut
choisir une autre icône dans la barre de défilement pour afficher les données sélectionnées.

10. Champ System status (État du système) : Indique le mode actif actuel et les messages d'avertissement éventuels.
11. Zone de données sélectionnées par l'utilisateur : Affiche toutes les données sélectionnées, y compris la progression

de l'analyse de démarrage, les messages de bonne gestion, les calendriers d'entretien et les avertissements.

Mise à jour du logiciel VesselView 4
Les instructions suivantes expliquent comment mettre à niveau le logiciel VesselView 4. Un accès Internet est nécessaire à
la réalisation de cette opération, de même qu'un port de communication pour le transfert du fichier vers une carte micro SD
FAT ou FAT 32.

Obtention de la dernière version du logiciel
1. La dernière version du logiciel de l'affichage est disponible en ligne pour téléchargement général depuis le site Web de

Mercury, www.mercurymarine.com. Pour déterminer quelle version du logiciel est installée sur VesselView, mettre
VesselView sous tension. Durant la procédure de démarrage du système, la version est affichée dans le coin inférieur
droit de l'écran. Si VesselView est déjà mis sous tension, sélectionner Settings>System>About
(Paramètres>Système>À propos) pour afficher la version actuelle du logiciel VesselView.

2.043.301

MERCURY MARINE

55831

56943

2. Sélectionner le produit VesselView 4 et cliquer sur DOWNLOAD UPGRADE (Télécharger la mise à niveau).
3. Selon les réglages de sécurité de l'ordinateur, un avertissement de sécurité peut s'afficher. Cliquer sur Allow

(Autoriser) pour continuer.
4. Créer un dossier sur le disque dur pour y enregistrer le fichier.
5. En cas d’affichage d’un message offrant de sélectionner SAVE (Enregistrer) ou RUN (Exécuter), sélectionner SAVE

(Enregistrer) et enregistrer le fichier sur le disque dur.
REMARQUE : La taille du fichier est généralement de 20 à 40 Mo.
IMPORTANT : Certains navigateurs peuvent modifier l’extension du fichier. Veiller à ne pas modifier le nom et
l'extension du fichier. L’extension correcte après le nom de fichier est .upd. Ne pas renommer le fichier, ni en modifier
l’extension.
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6. Une fois le fichier enregistré sur le disque dur, copier le fichier sur la racine d'une carte microSD FAT ou FAT 32 vierge
de 512 Mo minimum. La racine du lecteur est le niveau le plus élevé. Le fichier ne doit pas être placé dans un dossier.

Mise à niveau de VesselView
Éléments importants à prendre en compte avant et pendant le processus de mise à niveau :
• Chaque affichage doit être mis à niveau individuellement ; il n'existe aucune fonctionnalité de réseau permettant de

mettre à jour plusieurs VesselView de façon automatique et simultanée.
• Ne pas éteindre l'affichage ni commuter l'alimentation durant le processus de mise à niveau.
• Ne pas retirer la carte microSD durant le processus de mise à niveau.
1. Vérifier que la clé de contact est sur arrêt et que VesselView n'est pas mis sous tension.

REMARQUE : Sur certaines installations, VesselView peut être mis sous tension au moyen d'un circuit spécifiquement
prévu à cet effet, plutôt que par la clé de contact du circuit.
IMPORTANT : VesselView doit être hors tension depuis au moins 30 secondes avant de procéder à la mise à niveau
du logiciel.

2. Insérer complètement la carte microSD dans le port du lecteur de carte, jusqu'à ce qu'elle s'enclenche et reste en
place.

3. Mettre la clé de contact sur marche et vérifier que VesselView est sous tension.
4. Laisser le système démarrer. Le processus de mise à jour est automatique.
5. Ne pas mettre la clé de contact sur arrêt, mettre VesselView hors tension ni retirer la carte microSD durant le

téléchargement du logiciel. Le processus de mise à jour peut prendre plusieurs minutes.

Update in progress.
Please do not remove
the SD card or power off
during this process.

56561

6. Une fois le téléchargement terminé, retirer la carte microSD ; le système redémarre automatiquement afin d'achever la
mise à niveau.

Update complete.
Please remove the SD card to finish.

56563

7. Vérifier que la bonne version du logiciel a été mise à niveau. Appuyer sur le bouton PAGES et, à l'aide de la flèche
vers la DROITE, naviguer jusqu'au menu Settings (Paramètres). À l'aide de la touche ENTER (Entrée) et des boutons
fléchés, mettre en surbrillance System (Système) et sélectionner About (À propos). La version du logiciel actuelle est
indiquée.

Installation de la sonde de température d'air ambiant
REMARQUE : L'installation de la sonde de température d'air ambiant est optionnelle.
1. Sélectionner l'emplacement de la sonde de température d'air. Monter la sonde à un emplacement où elle sera

exposée à l’air, sans être exposée à la lumière directe du soleil.
2. Percer un trou de 19 mm (0.75 in.) .
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3. Installer l’adaptateur de montage comme illustré ci-dessous.

a - Adaptateur de montage
b - Joint
c - Écrou en nylon
d - Sonde de température de l’air

4. Visser la sonde dans l'adaptateur de montage.
5. Raccorder la sonde de température au connecteur du faisceau de VesselView.

Entretien
IMPORTANT :  Il est recommandé d'installer le pare-soleil fourni à des fins de protection lorsque l'unité n'est pas en
service.

Nettoyage quotidien de l'écran
Un nettoyage de routine de l'écran d'affichage est recommandé pour éviter une accumulation de sel et d'autres débris
environnementaux. Du sel cristallisé peut rayer le revêtement de l'affichage si un chiffon sec ou humide est utilisé. Veiller à
ce que le chiffon soit suffisamment imbibé d'eau douce pour dissoudre et éliminer les dépôts de sel. Ne pas appuyer de
façon agressive sur l'écran lors du nettoyage.
Si les marques d'eau ne peuvent pas être éliminées avec le chiffon, nettoyer l'écran avec une solution 50/50 d'eau chaude
et d'alcool isopropylique. Ne pas utiliser d'acétone, d'essence minérale, de solvants de type essence de térébenthine ni de
produits de nettoyage à base d'ammoniaque. L'utilisation de solvants ou de détergents puissants peut endommager le
revêtement antireflet, les parties en plastique ou les touches en caoutchouc.
Il est recommandé d'installer le pare-soleil lorsque l'unité n'est pas utilisée afin d'empêcher que les rayons UV
n'endommagent le cadre en plastique et les touches en caoutchouc.

Nettoyage du port média
La surface autour du cache du port média doit être nettoyée régulièrement afin d'empêcher toute accumulation de sel
cristallisé et d'autres débris. Un obturateur composite en caoutchouc rouge présent à l'intérieur du port de lecture de carte
microSD permet d'empêcher toute pénétration d'eau dans le port.
IMPORTANT : Installer l'obturateur après nettoyage ou mise à jour du logiciel.
REMARQUE : Installer l'obturateur avec la rainure vers le haut. Le côté opposé est doté d'un chanfrein afin d'empêcher
tout heurt entre le cache et l'obturateur.

52721

Boutons coincés
Vérifier qu'aucun bouton n'est coincé en position enfoncée. Si un bouton est coincé, le faire bouger pour le libérer.

a
b c d

10738
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Écran de démarrage
Un écran de démarrage Mercury s'affiche lorsque la clé de contact est mise sur marche. Le nombre d'heures de
fonctionnement peut atteindre 9 999 heures. La version du logiciel est indiquée dans le coin inférieur droit de l'écran. Dans
le cas d’ensembles de propulsion dotés d’un système de contrôle des émissions, une icône de moteur s’affiche dans le
coin inférieur gauche de l’écran.

51617

Écran de démarrage Mercury

Assistant Installation
IMPORTANT : Ne pas presser VesselView en appuyant sur des boutons tandis que le système démarre pour acquérir des
données du bateau et du moteur. Au démarrage initial de VesselView ou après une réinitialisation aux paramètres d'usine,
le système prend quelques secondes pour exécuter la procédure de démarrage.
L’Assistant Installation de VesselView guide le pilote au cours des premières étapes de la configuration de VesselView. Il
est possible d'accéder à tout moment à l'Assistant Installation par l'intermédiaire de l'icône SETTINGS (Paramètres) du
menu de la barre de défilement. Appuyer sur les boutons PAGES, RIGHT ARROW (Flèche droite) et sur la touche ENTER
(Entrée) (pour naviguer vers les menus Settings (Paramètres).

56815
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1. Sélectionner la langue dont l'affichage sur VesselView est souhaité. Utiliser les boutons fléchés LEFT (Gauche) et
RIGHT (Droit) pour faire défiler les options de langue. Appuyer sur la touche ENTER (Entrée) pour effectuer une
sélection. VesselView demandera confirmation du changement de langue et redémarrera. L'écran RESTARTING
(Redémarrage) s'affiche. Au retour de l'affichage, le texte tout entier sera dans la langue sélectionnée.

56823

2. Un écran de bienvenue s'affiche. Appuyer sur la flèche RIGHT (Droite) pour mettre en surbrillance le champ Next
(Suivant).

56793

3. L'écran principal de VesselView s'affiche dans la langue sélectionnée. L'icône SETTINGS (Paramètres) est en
surbrillance. Appuyer sur la touche ENTER (Entrée). System (Système) est en surbrillance dans le menu Settings
(Paramètres). Appuyer sur la touche ENTER (Entrée) pour afficher le menu déroulant. Appuyer sur le bouton fléché
RIGHT (Droit) pour faire défiler jusqu'à l'Assistant Installation(Setup wizard).

56792
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Importation de la configuration
Pour importer une configuration de bateau existante, insérer une carte microSD contenant le fichier de configuration et
sélectionner ce fichier dans le menu déroulant. En l'absence de fichier d'importation, utiliser le bouton fléché RIGHT (Droit)
pour mettre en surbrillance Next (Suivant) et appuyer sur ENTER (Entrée).

56794

Configuration des moteurs
1. À l'écran Engine Setup (Configuration des moteurs), appuyer sur les boutons fléchés RIGHT (Droit) et LEFT (Gauche)

pour mettre en surbrillance les champs déroulants. Procéder aux sélections en fonction du type et modèle de moteur.

60111

Sélection du type de moteur

60112

Sélection du modèle de moteur
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2. Faire défiler pour achever les sélections dans l'écran Engine Setup (Configuration des moteurs). Lorsque toutes les
sélections ont été effectuées, mettre en surbrillance Next (Suivant) et appuyer sur ENTER (Entrée).

60113

Sélection des options de la manette

60114

Sélection du nombre de moteurs

Configuration de l'affichage
Selon le nombre de moteurs indiqués sur l'écran Engine Setup (Configuration des moteurs), sélectionner les moteurs à
afficher par cette unité VesselView. Il est possible de sélectionner jusqu'à deux moteurs.

60116
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Configuration du dispositif
Dans l'écran Device Setup (Configuration des dispositifs), utiliser les boutons fléchés RIGHT (Droit) et LEFT (Gauche) pour
mettre en surbrillance les menus déroulants. Si plusieurs dispositifs VesselView sont utilisés, veiller à attribuer des
numéros uniques à chaque unité pour éviter des problèmes de données. Les numéros de barre doivent correspondre à
l’emplacement de l’unité VesselView individuelle. Mettre en surbrillance Next (Suivant) et appuyer sur ENTER (Entrée)
pour continuer.

a - Numéro de dispositif VesselView
b - Numéro d'emplacement de la barre

Units Setup (Configuration des unités)
Sélectionner les unités de mesure que VesselView affichera pour les données à l'écran, la vitesse, la distance et les
volumes. Les unités de mesure peuvent être modifiées individuellement plus tard. Après avoir sélectionné les unités de
mesure, mettre en surbrillance le champ Next (Suivant) et appuyer sur ENTER (Entrée).

60119

Configuration des réservoirs
Dans l'écran Tank Setup (Configuration des réservoirs), il est possible d’assigner le type, la contenance et le nom du
réservoir pour un maximum de 8 réservoirs. La colonne % affiche le volume des réservoirs en temps réel. Sélectionner le
bouton Refresh (Actualiser) pour interroger les capteurs de réservoir et rafraîchir les valeurs.

a

b

56802
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Un réservoir non surveillé est un réservoir n’ayant aucun capteur associé.

60120

À l'aide des boutons fléchés, naviguer parmi les options de types de réservoirs.

60121

Modifier les valeurs de contenance du réservoir à l'aide des boutons fléchés. À l'aide de la touche ENTER (Entrée), passer
au chiffre suivant. Après avoir modifié toutes les valeurs, appuyer sur la touche ENTER (Entrée) pour continuer.

60122
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Sélectionner la fenêtre Name (Nom) et, à l'aide des boutons fléchés, naviguer parmi le jeu de caractères.

60123

Sélectionner le bouton OK à l'aide des boutons fléchés et la touche ENTER (Entrée). En conséquence, l'écran de sélection
des réservoirs s'affiche de nouveau pour que l'opérateur puisse configurer un réservoir supplémentaire.

60124

Répéter le processus pour assigner le type, la contenance et le nom à chacun des réservoirs restants du bateau. À
l'achèvement ce processus, sélectionner le bouton Next (Suivant) et poursuivre la programmation à l'aide de l'Assistant
Installation.

60125
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Configuration de la vitesse
Dans l'écran Speed Setup (Configuration de la vitesse), trois options sont disponibles pour déterminer le mode
d'acquisition des informations relatives à la vitesse par VesselView. Si le bateau est équipé d'un GPS, le menu déroulant
permet la sélection des dispositifs disponibles. Si le bateau est équipé d’un capteur Pitot, cette option est sélectionnée. Si
le bateau est équipé d'une roue radiale, une option de sélection se déroule. Une fois la source de la vitesse sélectionnée,
mettre en surbrillance Next (Suivant) et appuyer sur ENTER (Entrée) pour continuer.

a - Options relatives aux données de vitesse

a - PCM0 = extérieur tribord
b - PCM1 = extérieur bâbord
c - PCM2 = central ou intérieur tribord
d - PCM3 = intérieur bâbord

Assistant de fin de la configuration
Mettre en surbrillance Finish (Terminer) à l'aide du bouton fléché RIGHT (Droit) et appuyer sur ENTER (Entrée) pour
conclure la configuration de VesselView. L'écran RESTARTING (Redémarrage) s'affiche. Ne pas mettre l’unité hors
tension avant que l’écran RESTARTING (Redémarrage) n'ait été remplacé par l’écran d’activité du bateau.

60128 60129

Configuration de la source des données
Mettre tous les produits sous tension et démarrer tous les moteurs pour garantir que toutes les sources de données
peuvent être détectées.
VesselView demande de configurer les sources de données détectables. Sélectionner OK pour continuer
Sélectionner Start (Démarrer) pour commencer le processus.

56810

a

a a ab b bc cd

60056

a
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REMARQUE : Si Cancel (Annuler) est sélectionné par erreur, il est encore possible de poursuivre ce processus en
naviguant vers Settings>System>Network>Auto Select (Paramètres>Système>Réseau>Sélection automatique). Auto
Select (Sélection automatique) scanne le réseau du bateau et identifie tous les dispositifs compatibles à bord.
Lorsque la sélection automatique est terminée, sélectionner Close (Fermer).

Écrans de démarrage
Démarrage

Lors du démarrage après la séquence d'écrans de démarrage, l'affichage principal est chargé et toutes les données ainsi
que tous les graphiques seront actifs. Deux cas de figure sont possibles : moteur arrêté ou moteur en marche. Le tableau
et les informations ci-dessous expliquent les séquences d'évolution des zones de données constantes et sélectionnées par
l'utilisateur.

État du moteur Zone de données sélectionnées par l'utilisateur
Moteur arrêté, clé de contact sur marche Message de bonne gestion
Démarrage du moteur Analyse du système en cours, affichage d'une hélice animée
Moteur tournant au ralenti L'hélice vire au vert
Moteur tournant en prise Données contextuelles intelligentes de niveau 1

Moteur arrêté, allumage sur marche
L'écran du message de bonne gestion Mercury s'affiche dans la zone des données sélectionnées par l'utilisateur lorsque
l'allumage est sur marche et que les moteurs ne tournent pas. Toutes les fonctions sont disponibles et aucune donnée
moteur n'est affichée.
• Les messages sont sélectionnés de manière aléatoire. Exemples : Disposez-vous de dispositifs de flottaison ?

Mercury vous rappelle de naviguer en toute sécurité.
• Le système de bonne gestion répertorie les éléments sujets à modification selon le type de moteur ou la

configuration de la personnalité.

Moteur tournant au ralenti
Lorsque le moteur tourne, une hélice verte s'affiche dans la zone de données sélectionnées par l'utilisateur de l'affichage
une fois le rapport d'analyse du système terminé.
• Dans la zone de données sélectionnées par l'utilisateur de l'écran figurent une hélice animée et une barre de

progression pour indiquer qu'une analyse est en cours.

Analyse du système
a - Hélice animée
b - Barre de progression

• Si le moteur est mis en prise à n'importe quel moment, l'analyse du système est interrompue ; l'hélice devient verte et
des données intelligentes de niveau 1 s'affichent.

a

b

51618 
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• Une fois l'analyse terminée, plusieurs fenêtres contextuelles peuvent s'afficher : engine faults (pannes moteurs),
maintenance reminders (rappels de maintenance), communication errors (erreurs de communication), system OK scan
report (rapport d'analyse de système OK).

52724

Analyse terminée

Panne de moteur
Si une panne du moteur est détectée durant une analyse de système, la zone de données sélectionnées par l'utilisateur
affiche une description dans un écran de panne de couleur vive. La couleur de l'écran de panne dépend du type de panne
détecté. Le champ d'état du système change en fonction de la panne affichée.

a - Icône d'avertissement avec intitulé de panne
b - Texte court ou texte de référence
c - Emplacement de la panne du moteur
d - Texte relatif à l'action
e - Nombre de pannes

Navigation parmi les pannes
Toute panne détectée sera identifiée par un numéro le long du pied de page du champ de panne.
1. L'onglet de sélection indique par défaut le premier numéro.
2. Appuyer sur la flèche GAUCHE ou DROITE pour passer chaque panne en revue.

a - Bouton PAGES
b - Flèche GAUCHE
c - Flèche DROITE
d - Bouton ENTER (Entrée)

3. La panne sélectionnée sera identifiée par un numéro noir sur fond blanc.
4. L'affichage de la panne sélectionnée alternera entre le numéro de panne et le symbole plus (+) pour indiquer

l'existence de données supplémentaires à afficher.

a - Nombre de pannes indiquées dans le pied de page
b - Panne sélectionnée
c - Icône Exit (Quitter) du pied de page des pannes

51619

a

b
c

d
e

51606

a b c d

51622 

a

b c
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5. Lorsque le symbole positif (+) est disponible, appuyer sur le bouton ENTER (Entrée) pour afficher les données
supplémentaires relatives à cette panne.

6. Lorsque l'affichage des données supplémentaires exige des pages supplémentaires, le pied de page des pannes
affiche un ou plusieurs cercles. Le cercle correspondant à la page sélectionnée est blanc. Une description longue de la
panne est affichée dans cette zone.

7. Pour quitter le pied de page des pannes, mettre le X du pied de page des pannes en surbrillance à l'aide du bouton
GAUCHE ou DROIT. Appuyer sur le bouton ENTER (Entrée) pour quitter le pied de page des pannes et revenir au
champ d'état du système.

Maintenance planifiée du moteur
Si un rappel de maintenance est détecté durant une analyse du système, la zone de données sélectionnées par l'utilisateur
affiche une description dans une couleur vive. Le champ d'état du système situé dans le coin inférieur gauche change
selon le problème d'entretien affiché. Faire preuve de bon sens pour protéger l'investissement réalisé et vérifier l'huile
moteur régulièrement, avant chaque utilisation de préférence.
1. Une fois l'intervalle d'entretien programmé entièrement écoulé, la zone de données sélectionnées par l'utilisateur

affiche un rappel d'entretien général invitant le pilote à procéder à l'entretien planifié.

52447 

2. Cliquer sur l'icône + pour développer le texte. Le pilote peut réinitialiser l'intervalle d'entretien à 100 % ou de quitter
l'écran.
REMARQUE : L'icône de rappel d'entretien en forme de clé est affichée dans le champ d'état du système jusqu'à ce
que la panne soit supprimée du système.

52448

3. Une fois le rappel d'entretien réinitialisé, l'icône en forme de clé ne s'affiche plus dans le champ d'état du système.

56985
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Analyse du système – Rapport d'analyse
Lorsqu'une analyse du système ne détecte aucune panne, aucun rappel d'entretien ni aucune erreur de communication, le
message SCAN COMPLETE (Analyse terminée) s'affiche dans la zone de données sélectionnées par l'utilisateur avec un
rapport et un message de bonne gestion. Le rapport d'analyse est affiché jusqu'à ce que le moteur soit mis en prise ; le
pilote peut également mettre le X en surbrillance à l'aide de la flèche GAUCHE ou DROITE et appuyer sur le bouton
ENTER (Entrée).
• Les messages de bonne gestion sont sélectionnés de manière aléatoire. Exemples : Disposez-vous de dispositifs de

flottaison ? Mercury vous rappelle de naviguer en toute sécurité.
• Le système de bonne gestion répertorie les éléments sujets à modification selon le type de moteur ou la

configuration de la personnalité.

51646 

Analyse terminée Message de bonne gestion

Erreurs de communication
Lorsqu'une erreur de communication est détectée lors de l'analyse du système, l'analyse est interrompue et toutes les
zones de données s'affichent avec des lignes en pointillés. Le champ d'état du système se grise, avec un X dans un cercle
rouge et un texte indiquant Comm Error (Erreur de communication).

51653

Erreur de communication
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Fonctionnalité du champ d'état du système
Le champ System Status (État du système) permet de communiquer des informations spécifiques concernant les moteurs
et les modes actifs. Ce champ est toujours présent dans le coin inférieur gauche de l'écran principal, sauf en cas
d'affichage d'un écran contextuel d'avertissement plein écran. Sa couleur, son icône et le texte qu'il contient varient selon
l'état du système, les avertissements, les messages d'entretien et les modes actifs. La personnalité du bateau et le type
d'installation de l'ensemble de propulsion ont un effet direct sur les icônes disponibles dans le champ d'état du système. Le
tableau suivant ne répertorie pas toutes les icônes disponibles.

Exemples d'état du système (System Status)

51875

Icône du moteur lorsque l'allumage est sur marche. Cette icône est visible uniquement si l'ensemble de
propulsion est doté d'un dispositif de contrôle des émissions.

52099 

Erreur de communication lorsque l'allumage est mis sur marche. L'ensemble de propulsion ne communique pas
par l'intermédiaire du réseau CAN.

52100 

Indique que chaque composant relié au réseau CAN fonctionne conformément aux paramètres de
fonctionnement normaux.

52101

Une icône d'avertissement indique une panne.

52102

Avertissement indiquant que la procédure de diagnostic embarqué du moteur tribord a détecté une panne. Tous
les autres emplacements de pannes identifiées du moteur sont similaires.

52104

Suivi des points de cheminement en pilotage automatique. La couleur orange indique que le suivi des points de
cheminement est actif et contrôlé par ordinateur. Si le suivi des points de cheminement en pilotage automatique
est en mode veille (inactif), le champ est grisé. Cette variation de schéma de couleur est identique pour toutes les
fonctions de pilotage automatique.



Section 3 - Présentation et fonctionnement des écrans

90-8M0126149   fra  MARS 2016 Page  23

Agrandissement des champs de données
Les champs de données peuvent être agrandis en mettant en surbrillance l'icône d'agrandissement (X-PAND) et en
appuyant sur le bouton Enter (Entrée).

52094 

Icône Agrandissement

Une fois l'icône activée, la zone de données sélectionnées par l'utilisateur comporte des données agrandies découlant de
la sélection de données affichées actives. Le pilote peut agrandir jusqu'à six sélections de données, en procédant une par
une, et les ordonner dans l'ordre chronologique, comme indiqué sur l'illustration suivante. Les champs de données 3 et 4
affichent uniquement les données optionnelles sélectionnées par l'utilisateur.
REMARQUE : Par défaut, le réglage de trim et des dérives ne s'agrandit que si ceux-ci sont activés au moyen de
commandes externes. S'ils sont activés, une fenêtre contextuelle contenant des instructions et des informations s'affiche.
Les fenêtres contextuelles relatives au trim et aux dérives peuvent être désactivées dans le menu Settings (Paramètres).
1. Volts or depth (Volts ou profondeur) : Ce champ de données peut être configuré par l'utilisateur. Une liste de tout le

contenu affiché disponible figure dans le menu Settings (Paramètres).
2. L'angle de direction est disponible si le capteur installé est raccordé au réseau CAN SmartCraft. L'angle de direction

est désactivé par défaut, mais il peut être activé manuellement dans le menu Settings (Paramètres).
3. Speed (Vitesse) : Affiche la vitesse du bateau. L'écran affiche des tirets si aucune source de vitesse n'est disponible.

L'affichage indique la valeur de vitesse, la source de la vitesse (roue radiale, pitot ou GPS) et les unités de mesure
(mi/h est l'unité par défaut). Les valeurs de vitesse comportant plus de deux chiffres sont indiquées dans une police de
taille plus petite.

4. RPM (Régime moteur) : Affiche une barre mobile représentant le régime moteur. Dans le cas d'une application à
moteurs jumelés, deux barres mobiles distinctes s'affichent.

5. Fuel (Carburant) : Ce champ de données affiche la quantité totale de carburant à bord.
• Affiche uniquement le volume total de carburant. Des données individuelles relatives au carburant sont indiquées

dans la zone de données sélectionnées, sous la rubrique consacrée à la gestion du carburant.
6. La barre de défilement permet au pilote de sélectionner différents écrans d'application Mercury à ouvrir dans la zone

de données sélectionnées. À l'aide du bouton PAGES et des boutons fléchés, naviguer entre les icônes de cette
section de l'écran.

7. Gear position (Position du pignon) : Les produits DTS indiquent toutes les positions du pignon de chaque moteur. Les
positions sont définies comme suit : F– Marche avant N– Point mort R– Marche arrière Les produits non-DTS indiquent
N– Point mort G– En prise

8. Trim : Ce champ de données peut être configuré par l'utilisateur. Affiche le trim d'un ou de deux moteurs. Une fenêtre
contextuelle de trim est disponible dans la zone de données sélectionnées par l'utilisateur. La fenêtre contextuelle de
trim peut être activée ou désactivée dans le menu Settings (Paramètres).

9. Icône de données sélectionnées : Affiche une icône représentant les données actuellement affichées dans la zone des
données sélectionnées de l'écran. Cette option permet également d'afficher l'icône des données sélectionnées
précédemment affichées si aucune donnée sélectionnée n'est actuellement affichée. Appuyer sur le bouton PAGES
pour ouvrir la barre de défilement. L'utilisateur peut sélectionner une icône dans la barre de défilement pour afficher
les données sélectionnées.

10. System status (État du système) : Indique le mode actif actuel et les messages d'avertissement éventuels.
11. Zone de données sélectionnées : Affiche toutes les données sélectionnées, y compris la progression de l'analyse de

démarrage, les messages de bonne gestion, les calendriers d'entretien et les avertissements.
12. L'icône Auto Cycle (Cycle automatique) affichera tous les écrans de données associés à la sélection d'un menu. Les

différents écrans s'afficheront séquentiellement à des intervalles prédéfinis par l'utilisateur.
13. L'icône X fermera ou quittera la zone de données sélectionnées par l'utilisateur.
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Chaque champ de données est associé à son propre indicateur de page dans le coin inférieur gauche de la zone de
données sélectionnées par l'utilisateur. À l'aide des flèches, naviguer vers les différentes pages ou sélectionner l'icône
Auto Cycle (Cycle automatique) ou l'icône Exit (Quitter). Appuyer sur le bouton Enter (Entrée) lorsque l'icône Auto cycle
(Cycle automatique) ou l'icône Exit (Quitter) sont en surbrillance.

a - Indicateurs de page
b - Icône Auto Cycle (Cycle auto‐

matique)
c - Icône Exit (Quitter)

Auto Cycle (Cycle automatique)
• Lorsque l'option Auto Cycle (Cycle automatique) est sélectionnée mais qu'elle n'est pas active, l'icône s'affiche sur un

fond blanc.
• Appuyer sur la touche ENTER (Entrée) pour activer le cycle automatique. L'icône s'affiche sur un fond bleu avec des

flèches blanches jusqu'à ce que le cycle automatique soit désactivé. La durée par défaut du cycle automatique est de
cinq secondes par page ; cette durée peut être modifiée dans le menu Settings (Paramètres).

• Lorsque le cycle automatique est actif, les boutons fléchés ne sont pas disponibles. Mettre l'une des pages en
surbrillance et appuyer sur le bouton Enter (Entrée). Le cycle automatique reste activé, mais il n'est pas visible. Pour
revenir au cycle automatique, mettre l'icône Auto cycle (Cycle automatique) en surbrillance et appuyer sur le bouton
Enter (Entrée).

• Pour désactiver le cycle automatique, mettre le X en surbrillance et appuyer sur le bouton Enter (Entrée). L'écran
quitte la zone de données sélectionnées par l'utilisateur.

Fonctionnalité de la barre de défilement
La barre de défilement permet d'accéder à des éléments actuellement non affichés dans la zone de données sélectionnées
par l'utilisateur de l'écran. L'élément est masqué jusqu'à ce qu'il soit activé et s'affiche pendant toute la durée spécifiée par
l'utilisateur dans le menu Settings (Paramètres). Si aucune activité n'a été enregistrée pendant plus de cinq secondes,
l'élément d'icône présent dans la zone de données sélectionnées par l'utilisateur se désactive. Lorsqu'elle est active, la
zone de données sélectionnée par l'utilisateur change d'aspect et indique le nom de l'icône, ainsi que les données relatives
à cette fonctionnalité.

Activation de la barre de défilement et navigation
1. Appuyer sur le bouton PAGES pour activer le menu de la barre de défilement.
2. À l'aide des flèches GAUCHE ou DROITE, mettre en surbrillance l'icône dont l'affichage est souhaité. Un contour bleu

met en surbrillance l'icône de la barre de défilement à sélectionner.
REMARQUE : Une icône fléchée s'affiche sur la gauche et la droite de la barre de défilement. Lorsqu'une seule icône
de flèche est visible, déplacer la sélection à l'aide de la flèche indiquée. Lorsque les feux flèches sont visibles, le pilote
peut utiliser l'une ou l'autre des flèches.

a - Icône sélectionnée
b - Flèches de la barre de défilement

a b
c

52095 

b

a

52051 
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Zone de données sélectionnées par l'utilisateur
Durant le processus de navigation à l'aide de la barre de défilement, si l'icône est en surbrillance et si la touche ENTER
(Entrée) n'est pas pressée, la zone de données sélectionnées par l'utilisateur change d'aspect et affiche l'icône, le nom de
celle-ci, ainsi qu'une description de ses fonctions. La zone de données sélectionnées par l'utilisateur affiche ces
informations pendant une période de 30 secondes au maximum. La durée pendant laquelle les données utilisateur mises
en surbrillance et la barre de défilement correspondante resteront affichées sans avoir à appuyer sur la touche ENTER
(Entrée) peut être définie en naviguant vers la fonction Preferences>Scroller Bar>Auto hide delay (Préférences>Barre de
défilement>Délai de temporisation automatique).

Choix final des données sélectionnées par l'utilisateur
Une fois l'icône sélectionnée, appuyer sur le bouton Enter (Entrée). L'icône s'affiche à côté du champ d'état du système ; la
zone de données sélectionnées par l'utilisateur affiche l'ensemble des données relatives à cette sélection.

Icônes de la barre de défilement
X-Pand (Développer)

X-Pand (Développer) – affichage des données agrandies depuis des écrans de données sélectionnés. Les données
sélectionnées s'affichent alternativement.

60706

Temperatures (Températures)
Temperatures (Températures) – affichage des valeurs de température du moteur et des fluides pour l'huile, l'eau et le
carburant. Affichage de la température de l'air ambiant et de l'air du collecteur. Les informations disponibles dépendent de
l'ensemble de propulsion.

60707

Pressure (Pression)
Pressure (Pression) – affichage des valeurs de pression du moteur pour l'eau, l'huile, le carburant et la suralimentation. Les
informations disponibles dépendent de l'ensemble de propulsion.

60709

Voltages (Tensions)
Voltages (Tensions) – affichage des valeurs de charge des batteries pour tous les moteurs.

60710

Fuel (Carburant)
Fuel (Carburant) – affichage des données du système d'alimentation en carburant : économie actuelle, économie
moyenne, volume consommé par heure, capacité totale et carburant consommé.

60711
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Réservoirs
Tanks (Réservoirs) – affichage des données relatives aux réservoirs embarqués sur le bateau pour les capacités en
carburant, eau propre, eau usée et huile moteur deux temps.

60713

Advanced (Paramètres avancés)
Advanced (Paramètres avancés) – affichage de données moteur complémentaires : température du collecteur,
pourcentage d'accélération, charge du moteur et pression de suralimentation du collecteur. Les informations disponibles
dépendent de l'ensemble de propulsion.

60714

Performances
Performances – performances de pointe (régime/vitesse) et pouces par tour d'hélice.

60715

Trim and Tabs (Trim et dérives)
Trim and Tabs (Trim et dérives) – affichage de la position du trim de l'embase et de la position des dérives. Pour que cette
fonction puisse afficher des informations, un capteur doit être installé sur les dérives.

60717

Trip Log (Journal des sorties)
Trip Log (Journal des sorties) – affichage des données de déplacement enregistrées : distance totale, durée totale, vitesse
moyenne, consommation moyenne de carburant. Les données enregistrées dans le Journal des sorties peuvent être
effacées et le Journal peut être remis à zéro.

60719

Navigation
Navigation – affichage des données du système de navigation embarqué : cap au compas, longitude et latitude, délai
jusqu'au point de cheminement (TTW), relèvement jusqu'au point de cheminement (BTW), distance jusqu'au point de
cheminement (DTW) et route sur le fond (COG).

60720
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Generator (Générateur)
Generator (Générateur) – affichage des données que le générateur peut envoyer par le biais d'un réseau CAN exécutant le
protocole J1939 ou NMEA 2000 : état (marche/arrêt) de l'alimentation électrique, tension (CA/CC), hertz, heures, pression
d'huile et température de l'eau.

60721

ECO (Économie)
ECO (Économie) – affichage des informations qui guident le pilote à obtenir la meilleure position de trim et le meilleur
régime moteur possibles pour optimiser sa consommation de carburant.
REMARQUE : Voir Economy Mode (Mode économie) dans cette section pour d'autres informations opérationnelles.

60722

Pilote automatique
Autopilot (Pilote automatique) – affichage des données de pilote automatique.
REMARQUE : Voir Autopilot Mode (Mode Pilote automatique) dans cette section pour d'autres informations
opérationnelles.

60723

Cruise (Régulateur de vitesse)
Cruise (Régulateur de vitesse) – activation du régulateur de vitesse. Permet à l'utilisateur de contrôler le bateau en
régulant sa vitesse ou le régime moteur. Le régulateur de vitesse du bateau nécessite la présence d'un capteur au niveau
de la roue radiale ou d'un GPS.
REMARQUE : Voir Cruise Control Mode (Mode Régulateur de vitesse) dans cette section pour d'autres informations
opérationnelles.

60724

Troll (Pêche à la traîne)
Troll Control (Commande de pêche à la traîne) – activation de la commande de bas régime moteur. Peut servir à réguler le
régime moteur.
REMARQUE : Voir Troll Control Mode (Mode Commande de pêche à la traîne) dans cette section pour d'autres
informations opérationnelles.

60725

Smart Tow
Smart Tow – activation des profils Smart Tow à des fins de sélection. Il est possible de modifier, d'ajouter et de
sauvegarder les profils.
REMARQUE : Voir Smart Tow Mode (Mode Smart Tow) dans cette section pour d'autres informations opérationnelles.

60726



Section 3 - Présentation et fonctionnement des écrans 

Page  28 90-8M0126149   fra  MARS 2016

Paramètres
Settings (Paramètres) – principal emplacement où le pilote peut activer ou désactiver les données, modifier la tolérance (±)
des données du capteur, sélectionner les préférences relatives aux valeurs affichées (métrique/impérial/nautique) et
rétablir les valeurs d'usine par défaut.
REMARQUE : La restauration des paramètres d'usine par défaut a pour effet d'effacer tous les paramètres personnalisés.
Voir la Section 4 pour plus de détails.

60727

Economy Mode (Mode économie)
ECO Mode (Mode ECO)

57376

Le mode ECO (Économie) affiche des informations qui guident le pilote de sorte à obtenir une position de trim optimale et
le meilleur régime moteur possibles pour optimiser sa consommation de carburant. Le module de commande du moteur
(ECM) ou le module de commande de propulsion (PCM) calcule l'économie de carburant optimale à partir des informations
en provenance de différents capteurs de l'ensemble de propulsion et du bateau.
1. Appuyer sur le bouton PAGES pour activer la barre de défilement.
2. Appuyer sur le bouton fléché pour mettre en surbrillance l'icône ECO et appuyer sur la touche ENTER (Entrée). La

zone de données sélectionnées par l'utilisateur affiche l'icône ECO (Économie) et un court descriptif quant à la façon
d'optimiser la consommation de carburant.

52165

REMARQUE : Lorsque le mode ECO (Économie) est actif, l'emplacement de la zone de données 4 du pied de page
du système affiche par défaut les valeurs de trim si une autre valeur de données est affichée. Les valeurs de trim
s'affichent dans le coin inférieur droit de l'écran si une autre valeur de données est déjà affichée.

52166

Valeurs de trim actives du mode ECO (Économie)
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Valeurs ECO minimales et maximales
Lorsque le mode ECO (Économie) est actif et que les moteurs sont en marche avant, les lignes de valeur minimale et
maximale s'affichent dans le balayage de régime moteur. Ces lignes affichent la plage optimisée active à calculer. Cette
fenêtre peut être réglée dans le menu Settings (Paramètres).

52167

Cibles de régime et de trim ECO
Lorsque les valeurs de régime atteignent la plage de valeur minimale, le régime et le trim cibles s'affichent. Une ligne
colorée suit le balayage de régime moteur avec des valeurs cibles colorées afin d'informer le pilote de la position de ces
valeurs. Les valeurs cibles changent de couleur une fois optimisées.

Couleurs des cibles

Règles de couleur des triangles
État Couleur Valeur de remplissage Action Image

Cible non atteinte Jaune Contour Clignotant

52170

Cible atteinte Vert Plein Continu

52171

Les exemples suivants montrent des cibles de régime ECO dans différents états.

52172 

Non optimisé Optimisé
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La zone de données sélectionnées par l'utilisateur affiche les cibles de trim.

52173

Une fois toutes les cibles atteintes, l'écran de la zone de données sélectionnées par l'utilisateur change d'aspect ; au lieu
d'afficher des instructions, il affiche OPTIMIZED (Optimisé) avec la valeur d'économie de carburant actuelle.

52174

Navigation ECO
Le pied de page de la zone de données sélectionnées par l'utilisateur affiche REFRESH (Actualiser), MINIMIZE (Réduire)
et X. Les boutons Pages, Arrow (Flèche) et Enter (Entrée) permettent de naviguer parmi ces fonctions.
• Minimize (Réduire) masque les instructions ECO et affiche ECO MODE (Mode économie) dans le champ d'état du

système. Minimize (Réduire) permet à l'utilisateur d'afficher d'autres informations dans la zone de données
sélectionnées par l'utilisateur.

• Refresh (Actualiser) permet de réinitialiser les valeurs ECO et de déterminer les valeurs de régime et de trim cibles à
partir de nouveaux paramètres.

• X ferme le mode ECO (Économie) et supprime les valeurs de régime et de trim cibles de la zone de données
constantes.

• La zone active est entourée d'un cadre blanc.

a - Refresh (Actualiser)
b - Permet de minimiser la fonction active
c - Exit (Quitter)

ECO Refresh (Actualiser ECO)
La fonction Refresh (Actualiser) permet de recalculer les valeurs utilisées par le mode ECO pour le régime et le trim cibles.
1. À l'aide des boutons fléchés, mettre la fonction Refresh (Actualiser) en surbrillance et appuyer sur Enter (Entrée).

52176

ba
c
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2. Des instructions s'affichent dans la zone de données sélectionnées par l'utilisateur. À l'aide de la flèche, mettre la
fonction Refresh (Actualiser) en surbrillance et appuyer sur Enter (Entrée).

52177

3. Une fois que le système a fini de calculer de nouvelles cibles, la zone de données sélectionnées par l'utilisateur
change d'aspect pour indiquer que les valeurs ont été actualisées.

4. Mettre le X en surbrillance et appuyer sur Enter (Entrée) pour revenir à l'écran d'instructions ECO principal.

52178

5. La zone de données sélectionnées par l'utilisateur ECO affiche des instructions et de nouvelles valeurs cibles
concernant l'optimisation de la consommation.

Minimize (Réduire)
Minimize (Réduire) est une fonctionnalité permettant à l'utilisateur de poursuivre l'utilisation des fonctionnalités ECO
(Économie), tout en affichant des informations supplémentaires dans la zone de données sélectionnées par l'utilisateur.
1. Lorsque Minimize (Réduire) est sélectionné, les instructions ECO sont supprimées et des informations

supplémentaires sont affichées dans la zone de données sélectionnées par l'utilisateur. Le pilote peut également
sélectionner plusieurs éléments dans la barre de défilement.
• La sélection de la barre de défilement est limitée à : Expand (Agrandissement), Fuel Management (Gestion du

carburant), Trip Log (Journal des sorties), Voltage (Tension), Navigation, Pressure (Pression), Temperature
(Température), Tanks (Réservoirs) et Generator (Générateur).
REMARQUE : Les éléments disponibles sur la barre de défilement dépendent des informations disponibles en
fonction de la personnalité du bateau et des instruments.

• Les éléments grisés sur la barre de défilement lorsque ECO est actif ne sont pas disponibles et ne peuvent donc
pas être sélectionnées.

2. Lorsque l'option Minimize (Réduire) est active, le champ d'état du système affiche ECO.
3. Pour agrandir le mode ECO (Économie), mettre l'icône ECO en surbrillance à l'aide des flèches et appuyer sur le

bouton Enter (Entrée).
4. Lorsque ECO est optimisé, la zone de données sélectionnées par l'utilisateur affiche OPTIMIZED (Optimisé).

Exit ECO (Quitter le mode ECO)
Pour quitter le mode ECO, sélectionner l'X dans la zone de pied de page des données sélectionnables par le pilote et
VesselView désactivera la fonction ECO.
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Modification des cibles ECO
Le logiciel en mode ECO surveille les capteurs du moteur et recherche la meilleure formule d'économie en cours
d'utilisation du bateau. Lorsque le logiciel identifie une amélioration en matière d'économie de carburant, VesselView
enregistre les valeurs courantes de trim et de régime. Ces calculs sont effectués que l'écran ECO (Éco) soit affiché ou non.
Une fois que le logiciel a enregistré les valeurs de trim et de régime, il guide le pilote, au moyen de flèches, jusqu'aux
réglages optimaux du régime et du trim. Pour la plupart des applications, il n'est pas nécessaire d'étalonner l'écran ECO
(Éco), mais certains paramètres peuvent être réglés afin de personnaliser la jauge en fonction du style de navigation. Les
paramètres par défaut sont compris dans une plage acceptable pour la plupart des applications. Les paramètres suivants
sont configurés par défaut et l'option de réglage peut être activée en appuyant sur la touche ENTER (Entrer) lorsqu'un
paramètre quelconque est mis en surbrillance.

60837 60838

Paramètres cibles ECO par défaut
Fuel economy stability (Stabilité de l'économie de carburant) 0,7 secondes
RPM stability (Stabilité de régime) 0,7 secondes
RPM window minimum (Fenêtre de régime minimal) 2 000 tr/min
RPM window maximum (Fenêtre de régime maximal) 4 000 tr/min
RPM target proximity (Proximité de la cible de régime) 10 %
Trim target proximity (Proximité de la cible de trim) 10 %

IMPORTANT : Un étalonnage de trim doit être effectué manuellement avant que l'écran ECO ne puisse être utilisé si
aucune personnalité du bateau n'a été chargée depuis une carte microSD. L'étalonnage par défaut du trim ne permet pas
le bon fonctionnement de l'écran ECO.

Modification des valeurs cibles
1. Appuyer sur le bouton PAGES pour ouvrir la barre de défilement.
2. À l'aide du bouton fléché, mettre l'icône des paramètres en surbrillance. Appuyer sur le bouton Enter (Entrée).
3. Appuyer sur le bouton fléché pour mettre Network (Réseau) en surbrillance et appuyer sur le bouton Enter (Entrée).
4. Appuyer sur le bouton fléché pour mettre ECO Mode (Mode ECO) en surbrillance et appuyer sur le bouton Enter

(Entrée).
5. Appuyer sur la flèche pour mettre en surbrillance la cible dont la modification est souhaitée – fenêtre de régime

minimum ou fenêtre de régime maximum et appuyer sur le bouton Enter (Entrée).
6. Appuyer sur les flèches pour modifier les chiffres individuels (X000). Appuyer sur le bouton Enter (Entrée) pour

enregistrer ce chiffre et passer au chiffre suivant (0X00), utiliser les flèches pour modifier ce chiffre.
7. Une fois le dernier chiffre (000x) modifié, appuyer sur la touche ENTER (Entrée).

REMARQUE : Le menu Settings (Paramètres) se ferme après avoir appuyé sur la touche ENTER (Entrée). Pour
modifier d'autres valeurs cibles, appuyer sur le bouton PAGES ; l'icône Settings (Paramètres) est mise en surbrillance.
Suivre la procédure décrite précédemment pour modifier d'autres valeurs cibles.

Smart Tow Mode (Mode Smart Tow)
Smart Tow

57377
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Smart Tow est un programme convivial permettant de gérer l’accélération du bateau et de cibler des régimes moteur pour
tracter des skieurs nautiques, des bouées tractées et tout autre type d’équipement de sport nautique. Smart Tow permet
d’éviter les problèmes d’accélération, comme les départs trop brusques, un dépassement ou une décélération trop
importants, et des vitesses cibles contradictoires. Sélectionner un profil, sélectionner activer, et placer la poignée de
commande en position de pleins gaz, Smart Tow s’occupe du reste.
Smart Tow se base sur le régime moteur, sauf si un GPS connecté au réseau CAN est installé sur le bateau. Lorsque le
bateau est équipé d'un GPS, il est possible de sélectionner des cibles de valeurs de vitesse ou de régime moteur pour les
options de commande Smart Tow. Le pilote peut également créer des profils de lancement personnalisés.

52179 

Caractéristiques
Smart Tow utilise la zone de données sélectionnées par l’utilisateur et la section de pied de page pour permettre au pilote
de régler les paramètres. Toucher ou balayer pour faire défiler les champs de la zone de sélection. La section de pied de
page permet au pilote d’activer ou désactiver, d’enregistrer ou de quitter Smart Tow. Pour mettre en surbrillance et
accepter les éléments situés dans le pied de page de la zone de données, il est nécessaire de les toucher ou d’utiliser le
bouton rotatif.
Smart Tow propose cinq profils de lancement prédéfinis en usine, mais le pilote peut créer de nouveaux profils de
lancement personnalisés. Les profils personnalisés sont très utiles lorsque les personnes à bord ont différents niveaux
d’expérience avec les équipements de sport nautique. Le pilote a la possibilité de créer des lancements plus agressifs pour
les skieurs nautiques expérimentés, ou des lancements plus doux pour les enfants, ou pour le remorquage de bouées.

52280 

Profils prédéfinis en usine

Il existe cinq champs de sélection pour chaque profil. Modifier la sélection des profils à l'aide des boutons fléchés et de la
touche ENTER (Entrée).
• Le point de consigne est le régime moteur ou la vitesse variable. Le pilote peut ajuster le régime ou la vitesse dans la

zone de l’écran de données.
• Ramp (Rampe) correspond à la durée nécessaire au bateau pour atteindre le point de consigne.
• Overshoot (Dépassement) correspond au pourcentage au-delà du point de consigne atteint par le bateau.
• La durée de dépassement autorisé du régime moteur (Overshoot) correspond à l’intervalle de temps pendant lequel le

bateau restera au-delà de la vitesse sélectionnée.
Après avoir réglé les paramètres souhaités, appuyer sur NEXT (Suivant) dans le pied de page de la zone de données.
L'écran clavier apparaît où l'opérateur sélectionnera un nom de fichier pour y enregistrer la liste des profils. Nommer le
profil et sélectionner la touche ENTER (Entrée) pour ajouter ce nouveau profil à liste.
L'activation ou la désactivation permet d'activer ou de désactiver la fonction. Les balayages de régime sont affichés sous
forme de balayages blancs non actifs lorsque la fonction est désactivée. Les balayages de régime sont affichés sous forme
de balayages actifs de couleur orange. Le pilote peut modifier tous les paramètres lorsque le Smart Tow est en mode
désactivé.
Sélectionnez OK. L'option Save (Enregistrer) a pour effet de modifier l'écran Smart Tow afin de permettre au pilote de
sélectionner un enregistrement rapide, d'enregistrer comme nouveau, de créer un paramètre personnalisé ou de supprimer
le profil.
Si le pilote appuie sur X, Smart Tow est désactivé et la zone de données constantes et sélectionnées par l'utilisateur
revient à l'écran par défaut.
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Activation de Smart Tow
Pour activer Smart Tow, sélectionner un profil de lancement prédéfini ou un profil personnalisé. Lorsque le bateau et la
personne remorquée sont prêts, régler la manette des gaz sur pleins gaz. Smart Tow débutera le profil de lancement. Un
point d'écran se déplace sur le chemin du profil, indiquant la progression du profil de lancement.
1. L'icône Enable (ON/Activer) est verte lorsqu'elle est active
2. L'icône Disable (OFF/Désactiver) est rouge lorsqu'elle n'est pas active
Le bateau poursuivra sa course au régime moteur prédéfini ou vitesse cible jusqu'à ce l'opérateur déplace la manette des
gaz sur la position de ralenti.

Valeurs Smart Tow
Smart Tow intègre des indicateurs de régime et de dépassement au sein des balayages de régime, modifiant ainsi la zone
de données constantes. Le point de consigne du régime est orange et l'échelle de dépassement est blanche.

a - Cible de point de consigne du régime
b - Échelle de dépassement

La représentation de la cible du point de consigne de régime passe d'un contour en mode inactif en un contenu plein en
mode actif.

Cible de point de consigne du régime
État Couleur Valeur de remplissage Image

Point de consigne Orange Contour

52182 

Actif Orange Plein

52183

Si Smart Tow est inactif, l'affichage du balayage de régime est blanc. Lorsque Smart Tow est actif, l'affichage du balayage
de régime est orange.

52184

L'affichage du balayage de régime actif est orange

Panneau de présentation Smart Tow
Avant la première utilisation de Smart Tow, un panneau de présentation s'affiche. Cet écran reste affiché pendant une
courte durée. Le panneau de présentation contient des instructions concernant la navigation dans l'écran Smart Tow. Le
pilote peut masquer l'aide, continuer ou quitter la fonction Smart Tow depuis cet écran.
• Lorsque HIDE HELP (Masquer l'aide) est choisi, l'écran d'aide ne s'affiche pas lors du cycle de lancement suivant et le

système continue à afficher l'écran Smart Tow par défaut.

a
b

52180
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• CONTINUE (Continuer) lance l'écran Smart Tow par défaut et conserve la page Overview (Présentation) dans la
séquence de lancement lors du lancement suivant de Smart Tow.

52185 

• X permet de quitter l'option Smart Tow.

Zone de données sélectionnées par l'utilisateur de Smart Tow
L'écran Smart Tow par défaut permet au pilote de sélectionner, définir et modifier les paramètres des fonctions Smart Tow.
Le point graphique de lancement est animé lorsque Smart Tow est actif et en cours de séquence de lancement. Le point se
déplace le long de la trajectoire de lancement indiquant la partie de la séquence de lancement exécutée par le système.

LAUNCH 2
52188

Point graphique animé de lancement

Navigation
Smart Tow utilise la zone de données sélectionnées par l'utilisateur et la section de pied de page de cette zone pour
permettre au pilote de régler les paramètres. Le bouton PAGES permet de déplacer la zone de sélection d'un champ à un
autre. La section de pied de page permet au pilote d’activer ou de désactiver, d’enregistrer ou de quitter Smart Tow.
Il existe cinq onglets de sélection. Le bouton PAGES permet de faire défiler la sélection de profil, les points de consigne de
vitesse/régime et l'activation/la désactivation. Lorsque l'onglet de sélection est sur Enable (Activer), les touches fléchées
permettent de modifier la sélection vers Save (Enregistrer) ou Exit (X [Quitter]).
• Les éléments situés dans la zone du pied de page nécessitent une pression sur le bouton Enter (Entrée) pour accepter

la sélection.
• Le bouton Enter (Entrée) n'est pas nécessaire pour le champ situé au-dessus de la zone de pieds de page.

a - Profile Selection (Sélection de profil)
b - Set point value (Valeur du point de consigne)
c - Enable (Activer)
d - Save (Enregistrer)
e - Exit (Quitter)

La valeur du point de consigne permet au pilote de régler le point de consigne de régime ou de vitesse. Tant que le pilote
n'a pas procédé à un enregistrement rapide des valeurs, celles-ci sont réglées par défaut sur 10 mph ou 1 700 tr/min.

b

c

d

e

52192

a
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• Le point de consigne correspond à la sélection par défaut lorsque Smart Tow est actif. Le pilote peut ajuster le régime
ou la vitesse à l'aide des flèches.

a - Sélection de la valeur par défaut du point de consigne

Une fois que le pilote a modifié les paramètres souhaités, une pression sur le bouton PAGES déplace le curseur jusqu'à la
sélection Enable (Activer) dans la zone de pied de page de la zone de données sélectionnées par l'utilisateur.
• L'activation ou la désactivation permet d'activer ou de désactiver la fonction. Les balayages de régime de données

persistantes sont affichés en tant que balayages inactifs blancs. Le pilote peut modifier tous les paramètres lorsque le
système est en mode désactivé.
a. L'icône Enable (Activer) est verte lorsqu'elle est active.
b. L'icône Disable (Désactiver) est rouge lorsqu'elle n'est pas active.

a - Non active – rouge
b - Balayage de régime normal affiché lorsque le mode

MPH (Vitesse) est sélectionné.

• À l'aide des boutons fléchés, mettre Save (Enregistrer) en surbrillance. L'option Save (Enregistrer) a pour effet de
modifier l'écran Smart Tow afin de permettre au pilote de sélectionner un enregistrement rapide, d'enregistrer comme
nouveau ou de créer un paramètre personnalisé.

• Si le pilote clique sur le X et appuie sur le bouton Enter (Entrée), Smart Tow est désactivé et les zones de données
constantes et sélectionnées par l'utilisateur reviennent à l'écran par défaut.

Save (Enregistrer)
Lorsque le pilote sélectionne Save (Enregistrer) et appuie sur le bouton Enter (Entrée), la zone de données sélectionnées
par l'utilisateur passe aux options d'enregistrement. Quick save (Enregistrement rapide) est l'option sélectionnée par
défaut.
• Le bouton PAGES permet de défiler parmi les choix proposés. Appuyer sur la touche ENTER (Entrée) pour confirmer

la sélection.

a - Quick save (Enregistrement rapide)
b - Save as new (Enregistrer comme nouveau)
c - Create custom (Personnaliser)

• QUICK SAVE (Enregistrement rapide) enregistre le profil existant avec les nouvelles valeurs de régime ou de vitesse.
Appuyer sur le bouton Enter (Entrée) pour enregistrer les données et revenir à l'écran Smart Tow.

• SAVE AS NEW (Enregistrer comme nouveau) permet au pilote d'enregistrer le paramètre actuel sous un nom
personnalisé. Appuyer sur la touche ENTER (Entrée) pour passer au nom de fichier personnalisé. Le nom de fichier
choisi est actif par défaut.
a. Modifier la lettre à l'aide des boutons fléchés

a

52281

52282

ba

a
b
c

52283
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b. À l'aide de la touche ENTER (Entrée), passer à la lettre suivante.

52284 

c. À l'aide du bouton PAGES, mettre Save (Enregistrer) en surbrillance et appuyer sur la touche ENTER (Entrée)
pour confirmer les modifications.
REMARQUE :  Si le pilote souhaite quitter, appuyer sur le bouton PAGES pour déplacer l'onglet de sélection
jusqu'au pied de page de navigation, sélectionner X à l'aide des touches de direction, puis appuyer sur la touche
ENTER (Entrée). L'affichage revient à l'écran principal sans enregistrer les nouvelles données.

Create Custom Launch (Création d'un lancement personnalisé)
Create Custom Launch (Création d'un lancement personnalisé) permet au pilote de créer un profil de lancement
personnalisé. Le pilote peut ajuster le point de consigne du régime ou de la vitesse, la rampe, le dépassement ou la durée
de dépassement. Lorsque le pilote sélectionne cette option, la zone de données sélectionnées par l'utilisateur passe à
l'écran de configuration de profil personnalisé.

52286

• Appuyer sur le bouton PAGES pour déplacer l'onglet de sélection jusqu'aux champs à ajuster. Les boutons fléchés
permettent d'ajuster la valeur de l'élément sélectionné.

• Une fois le profil personnalisé terminé, utiliser le bouton PAGES pour mettre en surbrillance Next (Suivant) ou X.
a. Si Next(Suivant) est sélectionné, la zone de données sélectionnées par l'utilisateur passe à SAVE AS NEW

(Enregistrer comme nouveau) pour créer un nom personnalisé pour le nouveau profil de lancement. Appuyer sur
la touche ENTER (Entrée) pour accepter la sélection.

b. Si Xest sélectionné, les réglages de profil personnalisé ne sont pas enregistrés et l'écran Smart Tow principal
s'affiche.

Désactivation de Smart Tow
Pour quitter Smart Tow, sélectionner DISABLE (Désactiver). VesselView transfert le contrôle de l’accélération au pilote.
Lorsque Smart Tow est activé, le fait de placer la manette des gaz en deçà de la vitesse cible a pour effet de réduire la
vitesse du bateau. En revanche, la vitesse maximale du bateau ne dépassera pas la vitesse cible.

Cruise Control Mode (Mode Régulateur de vitesse)
Cruise Control (Régulateur de vitesse)

57378

La fonction Cruise (Régulateur de vitesse) permet au pilote de sélectionner un point de consigne et de régler la valeur afin
que le bateau maintienne une vitesse ou un régime moteur spécifique.
• La fonction Cruise (Régulateur de vitesse) est basée sur le régime moteur, sauf si le réseau CAN du bateau intègre un

GPS Mercury Marine.
• Si le bateau est doté d'un GPS Mercury Marine, sa vitesse constitue le paramètre par défaut.
• Le pilote peut spécifier des points de consigne basés sur le régime moteur ou la vitesse. La sélection du type d'option

de régulateur de vitesse peut être modifiée dans le menu Settings (Paramètres).
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• Ouvrir la barre de défilement et mettre l'icône de régulateur de vitesse en surbrillance. Pour identifier l'icône du
régulateur de vitesse, voir Icônes de la barre de défilement.

Zones de données du régulateur de vitesse
Modification de champ de données constantes

Le régulateur de vitesse modifie le champ de données constantes de l'écran en intégrant un indicateur de régime dans le
balayage de régime, de manière similaire aux cibles Smart Tow et mode ECO (Économie).
• Lorsque le mode Cruise (Régulateur de vitesse) est activé, des éléments du champ de données constantes sont

modifiés afin de communiquer les paramètres suivants :
• RPM set-point (Point de consigne du régime).
• La couleur de balayage de régime passe à l'orange en mode actif pour indiquer que le moteur est régulé par

l'ordinateur.

a - Régulateur de vitesse inactif
b - Régulateur de vitesse actif

Régulateur de vitesse – Zone de données sélectionnées par l'utilisateur
Lorsqu'il est actif, le régulateur de vitesse modifie la zone de données sélectionnées par l'utilisateur de l'écran.
• Des éléments de la zone de données sélectionnées par l'utilisateur sont modifiés pour permettre à l'utilisateur de

configurer les paramètres suivants :
a. RPM set-point (Point de consigne du régime moteur)
b. État activé ou désactivé du régulateur de vitesse.

a - Set point value (Valeur du point de consigne)
b - Instructions
c - Enable (Activer)
d - Minimize (Réduire)
e - Exit (Quitter)

Navigation avec le régulateur de vitesse
Le mode Cruise (Régulateur de vitesse) est doté d'un système de navigation modifié similaire au Smart Tow. Le pied de
page de la zone de données sélectionnées par l'utilisateur permet au pilote d'activer ou de désactiver le régulateur de
vitesse, de réduire ou de quitter l'élément de programme. La navigation de pied de page suit la même stratégie de
sélection de base que les autres fonctions.
1. À l'aide des boutons fléchés, faire défiler les sélections.

a b

52278

a

b

c d
e

52279
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2. Appuyer sur la touche ENTER (Entrée) pour activer la sélection.

60839

a. L'activation ou la désactivation permet d'activer ou de désactiver le régulateur de vitesse. Après avoir sélectionné
Enable (Activer), régler la manette des gaz dans la position pleins-gaz et VesselView prendra le contrôle de la
vitesse de déplacement du bateau.

60841

Enable (Activer) sélectionné

60843

Disable (Désactiver) sélectionné
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b. Lorsque le régulateur de vitesse est désactivé, l'opérateur peut accélérer le déplacement du bateau à la vitesse
souhaitée ; le marqueur cible restera dans le balayage de régime moteur au point de consigne de vitesse de
croisière.

60844

c. La sélection de Enable (Activer) fait retourner le balayage de régime moteur au point de consigne de vitesse de
croisière.

60842

d. Minimize (Réduire) masque les données du régulateur de vitesse et affiche CRUISE (Régulateur de vitesse)
dans le champ d'état du système. Le pilote peut afficher des informations relatives à d'autres icônes
sélectionnées.

3. Le champ de sélection de réglage du point de consigne est l'emplacement par défaut au moment du démarrage du
régulateur de vitesse. Une fois que le pilote a modifié les paramètres souhaités, une pression sur le bouton PAGES
déplace l'onglet de sélection jusqu'à la sélection Enable/Disable (Activer/Désactiver) dans le pied de page de la zone
de données sélectionnées par l'utilisateur.
a. À l'aide des boutons fléchés, naviguer d'une sélection de point de consigne à une autre.
b. Lorsque l'onglet de sélection est en dehors de la zone de navigation (champ de point de consigne), il suffit au

pilote de modifier les réglages de régime ou de vitesse. Il n'est pas nécessaire d'appuyer sur la touche ENTER
(Entrée) pour appliquer le nouveau paramètre.

4. La fonction Minimize (Réduire) permet au pilote d'utiliser la fonction Cruise (Régulateur de vitesse) tout en affichant
des données supplémentaires dans la zone de données sélectionnées par l'utilisateur.
IMPORTANT : Les points de consigne ne peuvent pas être réglés lorsque Cruise (Régulateur de vitesse) est réduit.
a. La sélection de l'icône de la barre de défilement est restreinte. Les éléments non accessibles sont grisés lorsque

le régulateur de vitesse est actif.
b. Si le pilote automatique est actif alors que le régulateur de vitesse est réduit, le champ d'état du système affiche

CRUISE (Régulateur de vitesse).
• Les données de la fonction régulateur de vitesse sont affichées en superposition des paramètres du pilote

automatique si l'utilisateur sélectionne le champ d'état du système.
• Si une notification contextuelle relative au pilote automatique s'affiche ou si le pilote utilise le pavé tactile

CAN du pilote automatique, les données relatives au pilote automatique renseignent automatiquement la
zone de données sélectionnées par l'utilisateur. Pour masquer les données contextuelles, le pilote doit
réduire la fenêtre correspondante.

5. Une fois l'option Minimize (Réduire) active, le champ d'état du système affiche CRUISE (Vitesse de croisière).
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6. Lorsque quitter est sélectionné alors que l'élément de régulateur de vitesse est affiché et que le pilote appuie sur Enter
(Entrée), la fonction du régulateur de vitesse est désactivée. L'icône du régulateur de vitesse s'affiche à côté du champ
d'état du système jusqu'à ce qu'une autre icône soit sélectionnée dans la barre de défilement.

Troll Control Mode (Commande de pêche à la traîne)
Commande de pêche à la traîne

57379

La fonction Troll (Pêche à la traîne) permet au pilote de sélectionner un point de consigne et de régler la valeur afin que le
bateau puisse maintenir une vitesse ou un régime moteur spécifique.
• La fonction Troll (Pêche à la traîne) est basée sur le régime, sauf si le réseau CAN du bateau intègre un GPS Mercury

Marine.
• Si le bateau est doté d'un GPS Mercury Marine, sa vitesse constitue le paramètre par défaut.
• Le pilote peut spécifier des points de consigne basés sur le régime ou la vitesse. La sélection du type d'option de

pêche à la traîne peut être modifiée dans le menu Settings (Paramètres).
• Mettre l'icône Troll (Pêche à la traîne) en surbrillance à l'aide des flèches. Voir Icônes de la barre de défilement pour

identifier l'icône Troll (Pêche à la traîne).

Zone de données de la commande de pêche à la traîne
Modification de champ de données constantes

La fonction Troll (Pêche à la traîne) modifie le champ de données constantes de l'écran en intégrant un indicateur de
régime dans le balayage de régime, de manière similaire aux cibles Smart Tow et mode ECO (Économie).
• Lorsque le mode de commande Troll (Pêche à la traîne) est activé, des éléments du champ de données constantes

sont modifiés afin de communiquer les paramètres suivants :
• RPM set-point (Point de consigne du régime)
• La couleur de balayage de régime passe à l'orange en mode actif pour indiquer que le moteur est régulé par

l'ordinateur.

a - Inactif
b - Actif

Pêche à la traîne – Zone de données sélectionnées par l'utilisateur
Lorsqu'il est actif, le mode de pêche à la traîne modifie la zone de données sélectionnées par l'utilisateur de l'écran.
• Des éléments de la zone de données sélectionnées par l'utilisateur sont modifiés pour permettre à l'utilisateur de

configurer les paramètres suivants :
a. RPM set-point (Point de consigne du régime)
b. État activé ou désactivé du mode de pêche à la traîne

a - Set point value (Valeur du point de consigne)
b - Activer ou désactiver
c - Minimize (Réduire)
d - Exit (Quitter)

a b

52278

52457

a

b

c

d
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Navigation en mode Troll (Pêche à la traîne)
Le mode Troll (Pêche à la traîne) est doté d'un système de navigation modifié similaire au Smart Tow. Le pied de page de
la zone de données sélectionnées par l'utilisateur permet au pilote d'activer ou de désactiver le mode de pêche à la traîne,
de réduire ou de quitter l'élément de programme. La navigation de pied de page suit la même stratégie de sélection de
base que les autres fonctions.
1. À l'aide des boutons fléchés, naviguer parmi les sélections du pied de page.

60847

2. Appuyer sur la touche ENTER (Entrée) pour activer la sélection.
a. Activer ou désactiver la fonction de l'élément.

60846

Enable (Activer) sélectionné

60845

Disable (Désactiver) sélectionné

b. La sélection de Disable permet à l'opérateur de reprendre le contrôle de la commande des gaz : Le mode Troll
ne peut être réactivé que si la manette des gaz est placée en position de point mort et que la transmission est
toujours en prise.

c. Minimize (Réduire) masque les données du mode de pêche à la traîne et affiche TROLL (Pêche à la traîne) dans
le champ d'état du système. Le pilote peut afficher des informations relatives à d'autres icônes sélectionnées.
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3. Le champ de sélection de réglage du point de consigne est l'emplacement par défaut au moment du démarrage du
mode de pêche à la traîne. Une fois que le pilote a modifié les paramètres souhaités, utiliser les flèches pour
sélectionner Enable (Activer)/Disable (Désactiver) dans le pied de page de la zone de données sélectionnées par
l'utilisateur.
a. À l'aide des flèches, naviguer entre la sélection d'un point de consigne et le pied de page.
b. Lorsque l'onglet de sélection est au-dessus de la zone de navigation du pied de page (champ de point de

consigne), il suffit au pilote d'utiliser les flèches pour modifier le régime ou la vitesse. Il n'est pas nécessaire
d'appuyer sur Enter (Entrée) pour appliquer le nouveau paramètre.

4. La fonction Minimize (Réduire) permet au pilote d'utiliser la fonction Troll (Pêche à la traîne) tout en affichant des
données supplémentaires dans la zone de données sélectionnées par l'utilisateur.
IMPORTANT : Les points de consigne ne peuvent être réglés lorsque Troll (Pêche à la traîne) est réduit.
a. La sélection de l'icône de la barre de défilement est restreinte. Les éléments non accessibles sont grisés lorsque

le mode de pêche à la traîne est actif.
b. Si le pilote automatique est actif alors que la fonction de pêche à la traîne est réduite, le champ d'état du système

affiche TROLL (Pêche à la traîne).

60848

• Les données de la fonction de pêche à la traîne sont affichées en superposition des paramètres du pilote
automatique si l'utilisateur sélectionne le champ d'état du système.

• Si une notification contextuelle relative au pilote automatique s'affiche ou si le pilote utilise le pavé tactile
CAN du pilote automatique, les données relatives au pilote automatique renseignent automatiquement la
zone de données sélectionnées par l'utilisateur. Pour masquer les données contextuelles, le pilote doit
réduire la fenêtre correspondante.

5. Une fois l'option Minimize (Réduire) active, le champ d'état du système affiche TROLL (Pêche à la traîne).
6. La fonction TROLL (Pêche à la traîne) est désactivée si Exit (Quitter) est sélectionné alors que l'option de pêche à la

traîne est affichée. L'icône de la fonction de pêche à la traîne s'affiche à côté du champ d'état du système jusqu'à ce
qu'une autre icône soit sélectionnée dans la barre de défilement.

Écrans Autopilot (Pilote automatique)
Présentation des écrans Autopilot (Pilote automatique)

57380

VesselView est un affichage supplémentaire destiné aux fonctions de pilote automatique et aux opérations réalisées avec
la manette. Toutes les fonctionnalités de ces fonctions de pilotage sont contrôlées par le biais du pavé CAN de pilotage
automatique de Mercury Marine. VesselView indique si le mode est actif ou en veille ; des fenêtres contextuelles s'affichent
lorsque le bateau atteint un point de cheminement, pour demander au pilote de valider le changement de cap et un
message concernant le mode de réglage du moteur et des embases pour obtenir une efficacité maximale s'affiche.
• Si le pilote appuie sur un quelconque bouton du pavé tactile CAN du pilote automatique, VesselView affiche par défaut

l'écran Autopilot (Pilote automatique).
• Le pilote automatique est affiché de façon active lorsque cette fonction est activée. Cette fonction et tous les modes

sont contrôlés par le pavé CAN.

Navigation parmi les écrans d'Autopilot (Pilote automatique)
Les écrans Autopilot (Pilote automatique) ont un système de navigation modifié. Les informations sont affichées sur deux
pages de données. Les indicateurs de page et le X sont les seules sélections disponibles.
• La Page 1 comporte des informations de base concernant le pilote automatique.
• La Page 2 contient des données de navigation supplémentaires.
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• Le X permet de masquer les données du pilote automatique et d'afficher le mode de pilote automatique dans le champ
d'état du système. Cela permet l'affichage d'autres informations dans la zone de données sélectionnées par
l'utilisateur.

a - Pages
b - Permet de réduire les données d'Autopilot (Pilote automati‐

que)

Réduction du pilote automatique
Lorsque Minimize (Réduire) est sélectionné dans la zone de données sélectionnées par l'utilisateur, les données relatives
au pilote automatique sont supprimées. Des éléments limités de la barre de défilement peuvent être sélectionnés pour être
affichés dans la zone de données sélectionnée par l'utilisateur. Les dernières données sélectionnées par l'utilisateur sont
affichées par défaut.
• La sélection de la barre de défilement est limitée à : Expand (Agrandissement), ECO, Fuel Management (Gestion du

carburant), Trip Log (Journal des sorties), Voltage (Tension), Navigation, Pressure (Pression), Temperature
(Température), Tanks (Réservoirs), Cruise (Régulateur de vitesse), Genset (Paramètres du générateur) et Settings
(Paramètres).
REMARQUE : Les éléments disponibles dans la barre de défilement sont basés sur le moteur sélectionné dans
l'Assistant Installation.

• Si ECO est actif alors que le pilote automatique est réduit, le champ d'état du système affiche AUTO.
• Les éléments de la barre de défilement ne pouvant être sélectionnés sont grisés lorsque Autopilot (Pilote automatique)

est actif.
• Lorsqu'une fenêtre contextuelle de pilote automatique s'affiche ou qu'un bouton du pavé CAN de pilote automatique

est pressé, les données du pilote automatique renseignent automatiquement la zone de données sélectionnées par
l'utilisateur. Sélectionner X pour masquer les données.

• Le champ d'état du système affiche le mode actif dans lequel se trouve le pilote automatique : Track (Suivi), Auto,
Waypoint Sequence (Séquence de points de cheminement) ou Standby (Veille). Waypoint sequence (Séquence de
points de cheminement) s'affiche en orange dans le champ d'état du système, tous les autres modes s'affichent en
gris.

a b

52461
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Navigation dans le menu Settings (Paramètres)
Navigation dans le menu

1. Appuyer sur le bouton Pages.
2. Appuyer plusieurs fois sur le bouton fléché vers la droite jusqu'à ce que la dernière icône soit mise en surbrillance. La

dernière icône correspond au menu Settings (Paramètres).
3. Appuyer sur le bouton Enter (Entrée).
4. Appuyer sur les boutons fléchés vers la gauche ou vers la droite pour naviguer parmi les pages.
5. Appuyer sur le bouton Enter (Entrée) pour accéder au menu.
6. Après avoir modifié les paramètres, appuyer plusieurs fois sur le bouton Pages pour revenir à l'icône Réglages.

a - Bouton Pages
b - Bouton fléché vers la gauche
c - Bouton fléché vers la droite
d - Bouton Enter (Entrée)

System (Système)

56815

Le tableau suivant indique comment naviguer le menu Settings (Paramètres). Un astérisque (*) indique qu'une sélection
supplémentaire doit être effectuée à ce stade dans le menu.

System (Système)
Language > (Langue >) Sélectionner la langue souhaitée —
About > (À propos >) Version du logiciel Display —

Helm 1, Device 1 >
(Barre 1, Dispositif 1 >)

Select helm position > (Sélectionner la position
de la barre)

Arrêter le système et le remettre en
marche.

Sélectionner la liste Device (Dispositif). Cancel or Save and Restart (Annuler
ou Enregistrer et redémarrer)

Setup wizard > (Assis‐
tant Installation >).

Next to begin Setup wizard > (Suivant pour lan‐
cer l'Assistant Installation >) .

Restore defaults >
(Restaurer les paramè‐
tres par défaut >)

All Settings > (Tous les paramètres >)
Selected—dot, Not selected—empty
(Sélectionné—point, Non sélectionné
—vide)

Engine Limits > (Modèle de moteur >)
Selected—dot, Not selected—empty
(Sélectionné—point, Non sélectionné
—vide)

Alarm History > (Historique des alarmes >)
Selected—dot, Not selected—empty
(Sélectionné—point, Non sélectionné
—vide)

Network (Réseau >) Auto Select > (Sélection automatique >) Sources > (Sources >) Data Source Selection > (Sélec‐
tion de la source de données) *

Simulate > (Simuler >) ON—checkmark, OFF—no checkmark (Activé
—coché, Désactivé—décoché) *

Time (Date/Heure) >
Décalage de l'heure locale —
Time Format > (Format de l'heure >) 12 ou 24
Date Format > (Mode d'affichage de la date >) MM/JJ/AAAA ou JJ/MM/AAAA

Il est possible de modifier à tout moment n'importe quel paramètre à l'aide du menu Settings (Paramètres). Il est possible
de naviguer parmi tous les menus déroulants et volants à l'aide des boutons fléchés GAUCHE et DROIT et de la touche
ENTER (Entrée).

51606

a b c d
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Langue
Sélectionner la langue dont l'affichage sur VesselView est souhaité.
1. L'icône SETTINGS (Paramètres) étant en surbrillance, appuyer sur la touche ENTER (Entrée). L'écran du menu

Settings (Paramètres) s'affiche.

56791

2. Appuyer sur la touche ENTER (Entrée) pour ouvrir le menu « Alarms » (Alarmes). System (Système) Mettre en
surbrillance et sélectionner Language (Langue).

56825

About (À propos)
Afficher la version actuelle du logiciel VesselView.

Helm 1, Device 1 (Barre 1, Dispositif 1)
Définir l'identité exclusive de VesselView. Sur les bateaux à barres ou à VesselViews multiples, il est essentiel d'assurer
une transmission des données correcte sur le réseau.

Assistant Installation
Un outil de configuration simple et commode à utiliser. L'Assistant de configuration guidera l'opérateur dans la sélection
des données nécessaires du bateau, ce qui permettra de déterminer les fonctionnalités et options disponibles.
• Importation de la configuration à partir d'une carte micro SD
• Configuration du ou des moteurs

• Sélection du ou des types de moteur
• Sélection du modèle de moteur.
• Le bateau est équipé d'une manette des gaz, oui/non
• Sélection du nombre de moteurs

• L'écran Display setup (Configuration de l'affichage) permet de sélectionner quels moteurs seront affichés par
VesselView

• L'écran Device setup (Configuration du dispositif) permet de définir l'identité et l'emplacement de VesselView
• L'écran Units setup (Configuration des unités de mesure) permet de sélectionner quelles unités de mesure seront

affichées (métriques ou US standard). Il est possible à tout moment de personnaliser les unités de mesure à l'aide du
menu Preferences (Préférences).
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• Tank configuration (Configuration des réservoirs) permet de définir le type, la capacité et le nom des réservoirs du
bateau.

• Speed setup (Configuration de la vitesse) permet de sélectionner le type de dispositif qui transmettra les données de
vitesse au VesselView.

• À la conclusion des réglages, l'Assistant de configuration enregistre toutes les sélections et revient à l'écran de
navigation.

Restaurer les paramètres par défaut
Permet à l'opérateur d'effacer les paramètres, d'effacer l'historique des alarmes ou les limites de performance du moteur.
REMARQUE : L'effacement des limites de performance du moteur n'a aucun effet sur le système de protection du moteur
Engine Guardian. Les limites de performance du moteur se définissent au gré de l'opérateur et peuvent être modifiées ou
annulées à tout moment.

Network (Réseau)
Les paramètres de réseau permettent à l'utilisateur de sélectionner de nombreuses sources de données, de scanner le bus
CAN et la structure NMEA pour déterminer quels sont les composants de transmission de données d'entrée et de sortie
installés, et d'examiner les rapports de diagnostic, lesquels rapports fournissent des données sur les erreurs et les
dépassements intervenus sur les réseaux de communication CAN et NMEA. Une telle fonctionnalité peut s'avérer utile à
un technicien qualifié pour le diagnostic des erreurs de communication CAN et NMEA. Device List (Liste de dispositifs)
affiche tous les composants de rapports de données de bus CAN et de structure NMEA reconnus.
• Auto Select scanne le réseau du bateau et identifie tous les dispositifs compatibles à bord.
• L’option Supported Data (Données prises en charge) permet au pilote de sélectionner quels sont les types de données

affichées par VesselView. La sélection par défaut pour chaque élément est VesselView.

Configuration de la source des données
GPS > All data >(Tous les données >) Auto

Vessel > (Bateau >)
Heading (Cap), Vessel fuel rate (Consommation en
carburant du bateau), Rudder angle (Angle de gouvernail)
et Trim tabs (Dérives)>

Engine > (Moteur >) Port and Starboard (Bâbord et tribord)

Temp (Température), Oil Temp (Température
d'huile), Boost Pressure (Pression de
suralimentation), Oil Pressure (Pression d'huile),
Water Pressure (Pression d'eau), RPM (Régime
moteur), Alternator (Alternateur), Fuel Rate
(Consommation de carburant), Engine Hours
(Heures de fonctionnement du moteur),
Maintenance générale prédictive), Trim Status (État
de trim), Malfunction Indicator Light (Témoin
d'anomalie), Engine Performance (Rendement du
moteur)

Fuel Tank > (Réservoir de
carburant >)

Port Fuel and Starboard Fuel > (Réservoirs de carburant
bâbord et tribord

Fuel Tank > (Réservoir de
carburant) Port and Starboard > (bâbord et tribord >) Niveau de carburant et carburant restant

Water Tank > (Réservoir d'eau >) Water > (Eau >) Fresh Water Levels (Niveaux d’eau douce)
Live Well > (Viviers >) Live Well > (Viviers >) Live Well Level (Niveau de vivier)
Battery > (Batterie >) # > Battery Voltage (Tension de batterie)
Speed/Depth > (Vitesse/Profondeur
>)

Pitot Speed and Depth > (Vitesse de Pitot et profondeur
>) Source

Log/Timer > (Journal/Temporisateur
>) Water Distance > (Distance de l'eau) Calculé(e)

Environment > (Environnement >) Outside Temperature > (Température extérieure >) Sources

• Device List (Liste des dispositifs) affichera tous les composants identifiés au cours du processus Auto Select
(Sélection automatique)

• L'option Diagnostics (Diagnostic) permet d'afficher le type d'activité en cours et le pourcentage de charge des réseaux
CAN.

• La variation magnétique peut être réglée sur Auto (Automatique) ou modifiée en + ou en - d'un maximum de 5 chiffres,
y compris deux décimales.

• La fonction « Smart Contextual Enabled » (Activation de la fonction Données contextuelles intelligentes) permet
d'activer et de désactiver l'affichage numérique des régimes moteur dans la zone de données sélectionnées par
l'utilisateur.

• Le bus CAN H peut être désactivé afin de pouvoir diagnostiquer les problèmes de communication. Dans des
conditions de fonctionnement normales, cette fonctionnalité est toujours sélectionnée.

Simulate (Simuler)
Le mode « Simulate » permet de déconnecter VesselView du réseau et de générer des données aléatoires sur l'écran. Les
données affichées, quelles qu'elles soient, ne sauraient être considérées comme exactes ni utilisées pour le pilotage du
bateau. « Simulate » est conçu pour que l'opérateur se familiarise avec VesselView avant de l'utiliser sur l'eau.
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Time (Heure)
Les paramètres d'heure peuvent être modifiés par la sélection de : Heure locale, format 12/24 heures et mode d'affichage
de la date.
Le signe supérieur à (>) indique des options de menu supplémentaires. Un astérisque (*) indique des informations
complémentaires sur l'élément de menu considéré.

Bateau

56815

56817

Vessel permet à l'opérateur d'assigner la source des données d'un onglet ; de configurer les noms et les capacités des
réservoirs ; de déterminer la source de la vitesse mesurée ; d'assigner des valeurs de vitesse et de température de l'eau
de mer ; d'identifier le décalage du transducteur de profondeur, la source des moteurs, le nombre de réservoirs de
carburant et la capacité totale du ou des réservoirs de carburant. La contenance en carburant peut également être
réinitialisée après remplissage.
Le signe supérieur à (>) indique des options de menu supplémentaires. Un astérisque (*) signale des informations
complémentaires sur l'élément de menu considéré.

Bateau

Tabs (Dérives)
> Source > (Source >)

Starboard Calibration > (Étalonna‐
ge tribord)

Calibration Window > (Fenêtre
d'étalonnage)

Reset (Réinitialiser), Save (Enregistrer)
ou Cancel (Annuler)

Outboard Calibration > (Étalonna‐
ge du moteur hors-bord)

Calibration Window > (Fenêtre
d'étalonnage)

Reset, Save, ou Cancel (Réinitialiser,
Enregistrer ou Annuler)

Tanks >( Ré‐
servoirs >)

Tank name and position
> (Nom du réservoir et
position >)

Calibration (Étalonnage) > Calibration Window > (Fenêtre
Étalonnage >)

Reset, Save, or Cancel * (Réinitialiser,
Enregistrer ou Annuler *)

Speed (Vites‐
se) > Commande de vitesse.

Strategy or GPS > (Strategy ou
GPS >) GPS > (GPS >) CAN P ou CAN H (CAN P ou CAN H)

Pitot > (Pitot >) Pitot Source > (Source Pitot >) Sensor Type (Type de capteur)

Paddle wheel > (Roue radiale >) Paddle wheel Source > (Source
de la roue radiale)

Sensor—Current or Legacy (Capteur—
Actuel ou ancien)

Steering > (Di‐
rection >)

Steering Angle Source
> (Source de l'angle de
direction >)

Selection (Sélection)
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Bateau

Show > (Afficher >) Dot—display, Empty—hide (Point
—afficher, Vide—masquer)

Invert Steering >(Inver‐
sion de la direction)

Dot—yes, Empty—no (Point—oui,
Vide—non) *

Offset (Correction) > Offset options > (Options de déca‐
lage >)

Save or Cancel (Enregistrer ou
Annuler) *

Sea Temp >
(Température
de l’eau de
mer >)

Selection > (Sélection
>)

Depth Offset >
(Correction de
profondeur >)

Offset (Correction) > Offset options > (Options de déca‐
lage >) Calibration (Étalonnage) > Save or Cancel (Enregistrer ou Annu‐

ler)

Tabs (Dérives)
Tabs Data Source (Source des données des dérives) peut être sélectionnée avec ce paramètre. « Tab Data Source »
comprend : dérives, TVM (Module d’orientation de la poussée) et PCM.
Suivent les positions des options Tab Source
1. PCM0 = moteur extérieur tribord
2. PCM1 = moteur extérieur bâbord
3. PCM2 = moteur intérieur tribord ou intérieur
4. PCM3 = moteur intérieur bâbord
5. TVM = embase en nacelle
6. TAB = module de dérive
L'option Show (Afficher) permet de déterminer si les données de dérive seront affichées à l'écran : checked (coché) = yes
(oui) ou unchecked (non coché) = no (non).
L’étalonnage des dérives permet au pilote de placer les dérives dans leur position la plus haute et la plus basse et
d’enregistrer les pourcentages. Cela est utile pour déterminer la vraie position à 0° des dérives, point auquel les dérives
sont parallèles avec le fond du bateau. Les dérives correctement étalonnées affichent une position précise de leurs
curseurs à l’écran.
Pour étalonner les dérives, placer la dérive parallèlement à la coque, et noter la valeur qui correspondra au 0 % réel pour
la dérive. Abaisser complètement la dérive, et noter la valeur qui correspondra au 100 % réel pour la dérive. Sélectionner
SAVE (Enregistrer) pour enregistrer les nouvelles données d’étalonnage des dérives.

Réservoirs
Il existe de nombreuses situations dans lesquelles l’étalonnage d’un réservoir est nécessaire, notamment pour les
réservoirs de forme atypique, les réservoirs à fond en V, les réservoirs à parois étagées, voir l’aspect du réservoir lorsque
le bateau est à l’eau. Les flotteurs et les sondes peuvent transmettre des données erronées au pilote, à l’origine de
problèmes liés au carburant ou aux volumes. La méthode la plus précise pour réaliser l’étalonnage des réservoirs est de
commencer par un réservoir vide de contenance connue. Remplir un quart de la contenance et noter la position du flotteur
ou de la sonde. Répéter cette procédure par incréments d’un quart, en notant la position du flotteur ou de la sonde à
chaque étape, jusqu’à ce que le réservoir soit plein.
La configuration des réservoirs (Configure Tanks) est prise en charge par l’Assistant de configuration, mais il est possible
d’apporter des modifications à tout moment.

Étalonnage du réservoir
L’étalonnage d’un réservoir permet au pilote d’ajuster les valeurs de contenance d’un réservoir, du plein jusqu’au vide.
Lorsqu’un réservoir est affiché en surbrillance, sélectionner ENTER (Entrée) pour activer l’écran d’étalonnage.
Les paramètres par défaut se trouvent dans la seconde colonne et peuvent être sélectionnés en appuyant sur les boutons
fléchés. Dans l’exemple suivant, il est avéré que le réservoir est plein, mais une valeur de 79 pour cent du plein est
relevée. Sélectionner le bouton d’enregistrement (RECORD) dans la ligne 100 pour cent. VesselView considère désormais
qu'une valeur de 79 pour cent correspond au plein, et ajuste les valeurs de moitié de contenance et de vide en
conséquence. Lorsque le niveau d’un réservoir est connu par le pilote, l’étalonnage du réservoir peut être utilisé pour
corriger la valeur affichée par la jauge pour correspondre au volume connu à tout moment.

Vitesse
Les paramètres de vitesse sont pris en charge par L'Assistant Installation mais la sélection des éléments GPS, tube de
Pitot et roue radiale peut être modifié à l'aide de ce menu. Strategy et GPS sont les options. Si le bateau est équipé d’un
GPS connecté au réseau CAN, choisir cette option. Si le bateau est équipé d’un capteur Pitot et/ou d'une roue radiale, il
faut sélectionner cette option. Une stratégie de gestion de la vitesse fondée sur des capteurs Pitot et des roues radiales est
traitée plus bas dans cette section.
La source de vitesse dispose d’une option de sélection d’un GPS et d’une source GPS, du réseau CAN P ou CAN H. Il est
également possible de sélectionner une stratégie utilisant un capteur Pitot et/ou une roue radiale. Le choix des options
Pitot ou roue radiale permet d’afficher la sélection des sources.
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Les positions des options PCM sont indiquées dans l'illustration suivante.

a - PCM0
b - PCM1
c - PCM2
d - PCM3

Le seuil STW (Speed-through-water) est la vitesse de transition approximative à laquelle les calculs d'une roue radiale
s'effectuent par une source différente : GPS ou capteur Pitot. Pour modifier le nom du réservoir, sélectionner le champ et
utiliser le pavé numérique virtuel pour personnaliser le nom du réservoir.

Direction
Les données de source de la direction peuvent être prises par l’intermédiaire du PCM ou du TVM, module de vecteur de
poussée, avec l’option d’afficher les données à l’écran, d’inverser l’entrée de la direction et de déterminer un degré de
décalage de la direction.
L’option d’inversion de la direction est utile lorsqu’un dispositif VesselView est orienté vers l’arrière. Dans ce cas, les
données de la direction correspondent au sens d’observation du pilote.
La fonction « Steering Offset » (Correction de la direction) est utilisée pour aligner le moteur hors-bord, la transmission en
Z ou le moteur inboard sur 0°. Lorsque l’embase est positionnée perpendiculairement à la coque, l’angle de direction
affiché à l’écran peut ne pas correspondre à celui du capteur de direction monté sur l’embase. Pour ajuster cet écart,
sélectionner l'onglet Offset (Décalage). La boîte de dialogue Steering Angle Calibration (Étalonnage de l’angle de direction)
s’affiche. Appuyer sur le bouton Zero (Zéro) de la ligne Calibrated (Étalonné) pour appliquer le décalage. Remarquer que le
décalage ne varie pas sur l’écran d’affichage tant que le bouton Save (Enregistrer) n’a pas été sélectionné.

Sea Temp (Température de l’eau de mer)
En fonction du type de transmetteur de température qui équipe le bateau, l'opérateur peut sélectionner la source des
données. Les options PCM sont disponibles sur les bateaux équipés d'un capteur SmartCraft. Les options Airmar® sont
destinées aux bateaux équipés d'un capteur branché sur une connexion de diagnostic à 4 broches. Le tableau illustre la
position du moteur utilisée pour la transmission des données de température au VesselView.

Capteur SmartCraft Capteur Airmar
PCM0 Moteur extérieur tribord Airmar0 Moteur extérieur tribord
PCM1 Moteur extérieur bâbord AirMar1 Moteur extérieur bâbord
PCM2 Moteur intérieur tribord ou central Airmar2 Moteur intérieur tribord
PCM3 Moteur intérieur bâbord AirMar3 Moteur intérieur bâbord

Depth Offset (Correction de la profondeur)
Depth Offset (Correction de la profondeur) est la distance qui sépare le transducteur de la ligne de flottaison. La valeur par
défaut de la correction est de 0.0 foot (0,0 pied). Pour définir une correction en dessous du transducteur, retrancher de la
correction de profondeur Pour définir une correction au-dessus du transducteur, ajouter à la correction de profondeur.

a - Depth transducer (Transducteur de
profondeur)

b - Pour définir une correction en des‐
sous du transducteur, retrancher
de la correction de profondeur

c - No offset (Pas de correction). Dis‐
tance du transducteur de profon‐
deur au fond.

d - Pour définir une correction au-des‐
sus du transducteur, ajouter à la
correction de profondeur

a a ab b bc cd

60056

a

32883

b
c

d

a
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Engines (Moteurs)

56815

56818

Il est possible de définir le type et le modèle de moteur. Il est possible de définir des limites au fonctionnement du moteur
en fixant des valeurs maximales et minimales aux paramètres opérationnels. Il est possible d'activer ou de désactiver la
sélection d'éléments de données à partir de ce menu. Les paramètres ECO, Cruise, Smart Tow et trim peuvent être réglés
à partir du menu Engines Settings (Paramètres des moteurs).
Le signe supérieur à (>) indique des options de menu supplémentaires.

Moteurs

Engines Shown >
(Moteurs illustrés >) Select > (Sélectionner >)

Port, dot—yes, Empty—no (Bâbord,
Point—oui, Vide—non)
Starboard, dot—yes, empty—no
(Tribord, Point—oui, Vide—non)

Engine model > (Mo‐
dèle de moteur >) Select

Limits (Limites) >

RPM > (Sélectionner le
régime moteur >)

Min, Max, and Warnings Options >
(Min, Max et Options d'avertisse‐
ment >)

Reset (Réinitialiser), Save (Enre‐
gistrer) ou Cancel (Annuler)

Fuel Rate > (Consomma‐
tion de carburant)

STBD or PORT > (Tribord ou Bâ‐
bord)

Min, Max, and Warnings Options
> (Min, Max et Options d'avertis‐
sement >)

Reset (Réinitialiser), Save
(Enregistrer) ou Cancel (An‐
nuler)

Coolant Temp > (Tempé‐
rature du liquide de refroi‐
dissement)

Min, Max, and Warnings Options >
(Min, Max et Options d'avertisse‐
ment >)

Oil Temp > (Température
d'huile >)

Min, Max, and Warnings Options >
(Min, Max et Options d'avertisse‐
ment >)

Reset (Réinitialiser), Save (Enre‐
gistrer) ou Cancel (Annuler)

Oil Pressure > (Pression
d'huile >)

Min, Max, and Warnings Options >
(Min, Max et Options d'avertisse‐
ment >)

Reset (Réinitialiser), Save (Enre‐
gistrer) ou Cancel (Annuler)

Water Pressure > (Pres‐
sion d'eau >)

Min, Max, and Warnings Options >
(Min, Max et Options d'avertisse‐
ment >)

Reset (Réinitialiser), Save (Enre‐
gistrer) ou Cancel (Annuler)

Battery Voltage (Tension
de batterie) :

Min, Max, and Warnings Options >
(Min, Max et Options d'avertisse‐
ment >)

Reset (Réinitialiser), Save (Enre‐
gistrer) ou Cancel (Annuler)
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Moteurs

Intake Temp > (Tempéra‐
ture à l'admission >)

STBD or PORT > (Bâbord ou Tri‐
bord >)

Min, Max, and Warnings Options
> (Min, Max et Options d'avertis‐
sement >)

Reset (Réinitialiser), Save
(Enregistrer) ou Cancel (An‐
nuler)

Boost Pressure > (Pres‐
sion de suralimentation >)

STBD or PORT > (Bâbord ou Tri‐
bord >)

Min, Max, and Warnings Options
> (Min, Max et Options d'avertis‐
sement >)

Reset (Réinitialiser), Save
(Enregistrer) ou Cancel (An‐
nuler)

Trans Oil Pressure >
(Pression de l'huile de
transmission >)

STBD or PORT > (Bâbord ou Tri‐
bord >)

Min, Max, and Warnings Options
> (Min, Max et Options d'avertis‐
sement >)

Reset (Réinitialiser), Save
(Enregistrer) ou Cancel (An‐
nuler)

Trans Oil Temperature >
(Température de l’huile de
transmission >)

STBD or PORT > (Bâbord ou Tri‐
bord >)

Min, Max, and Warnings Options
> (Min, Max et Options d'avertis‐
sement >)

Reset (Réinitialiser), Save
(Enregistrer) ou Cancel (An‐
nuler)

Supported Data >
(Données prises en
charge >)

Actual Gear > (Rapport
sélectionné >)

Dot—yes, empty—no (Point—oui,
Vide—non)

Boost Pressure > (Pres‐
sion de suralimentation >)

Dot—yes, empty—no (Point—oui,
Vide—non)

Fuel Pressure > (Pression
du carburant >)

Dot—yes, empty—no (Point—oui,
Vide—non)

Gear Pressure > (Pres‐
sion d'engrenages >)

Dot—yes, empty—no (Point—oui,
Vide—non)

Gear Temperature >
(Température des engre‐
nages >)

Dot—yes, empty—no (Point—oui,
Vide—non)

Load Percent > (Pourcen‐
tage de charge >)

Dot—yes, empty—no (Point—oui,
Vide—non)

Manifold Temperature >
(Température du collec‐
teur >)

Dot—yes, empty—no (Point—oui,
Vide—non)

Oil Pressure > (Pression
d'huile >)

Dot—yes, empty—no (Point—oui,
Vide—non)

Oil Temperature (Tempé‐
rature de l'huile)

Dot—yes, empty—no (Point—oui,
Vide—non)

Throttle Percent > (Pour‐
centage d'accélération >)

Dot—yes, empty—no (Point—oui,
Vide—non)

Water Pressure > (Pres‐
sion d'eau >)

Dot—yes, empty—no (Point—oui,
Vide—non)

ECO Mode > (Mode
ECO >)

Fuel Economy Stability >
(Économie de carburant
(liquide)

Enter Data (Entrer données)

RPM Stability > (Stabilité
du régime moteur >) Enter Data (Entrer données)

RPM Window Minimum >
(Fenêtre de régime mini‐
mal >)

Enter Data (Entrer données)

RPM Window Minimum >
(Fenêtre de régime mini‐
mal >)

Enter Data (Entrer données)

RPM target proximity >
(Proximité de la cible de
régime >)

Enter Data (Entrer données)

Trim target proximity >
(Proximité de la cible de
trim >)

Enter Data (Entrer données)

Cruise/SmartTow type
> (Type Régulateur
de vitesse/SmartTow)
>

RPM—Auto, RPM, or
Speed (Régime moteur—
Auto, Régime moteur ou
Vitesse)

Trim >
Show—PORT and STBD
> (Show—Bâbord et Tri‐
bord >

Has Trim—dot—yes, empty—no
(Trim—point—yes, vierge—non)

Calibration Data > (Données
d'étalonnage)

Reset (Réinitialiser), Save
(Enregistrer) ou Cancel (An‐
nuler)

Engines Shown (Moteurs illustrés)
L’option Engines Shown (Moteurs illustrés) est prise en charge par le processus de l’Assistant Installation, mais les options
d’affichage peuvent être modifiées à tout moment dans le menu Engines Settings (Paramètres des moteurs). VesselView
peut afficher jusqu’à deux moteurs, en fonction du nombre de moteurs sélectionné au cours du processus de l’Assistant
Installation. L’opérateur a la possibilité de sélectionner les moteurs à afficher. Cocher ou décocher les moteurs pour
déterminer les moteurs à afficher sur VesselView.

Engine Model (Modèle de moteur)
Les paramètres de modèle de moteur permettent à l’utilisateur de modifier les descriptions des ensembles de propulsion.
L’option de modèle de moteur est prise en charge par l’Assistant Installation, mais il est possible d’apporter des
modifications à tout moment. Toute modification effectuée ici est susceptible de rendre d’autres paramètres et options
indisponibles dans VesselView. Utiliser le bouton rotatif pour passer en revue la liste des moteurs et appuyer sur le bouton
rotatif pour effectuer une sélection.
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Limits (Limites)
L’option Limits (Limites) permet de configurer des plages spécifiques pour de nombreux paramètres de données moteur,
notamment le régime moteur, la température du liquide de refroidissement, la température de l’huile, la tension de batterie
et la pression de suralimentation. Les modifications apportées à ces limites n’affectent pas le ou les moteurs, ni le
programme Engine Guardian de Mercury. Les limites réelles du moteur sont déterminées par le module de gestion du
moteur programmé en usine.

Paramètre Description
Min. : Valeur de la base du graphique à l’écran
Max : Valeur du haut du graphique à l’écran
Alarme basse : Valeur en haut de la section inférieure rouge du graphique à l’écran
Alarme haute : Valeur en bas de la section supérieure rouge du graphique à l’écran

Supported Data (Données prises en charge)
Les paramètres Supported Data (Données prises en charge) permettent au pilote de sélectionner quelles données de
moteur et d'embase seront affichées à l'écran. Les boîtes de données sont présélectionnées en fonction du modèle de
moteur sélectionné mais peuvent être modifiées à tout moment. Les données prises en charge varient d'un moteur à
l'autre.

ECO Mode (Mode ECO)
Les paramètres ECO Mode permettent d'ajuster les intervalles d'actualisation de l'affichage du régime moteur et de la
consommation de carburant, de modifier la plage de régime moteur souhaitée ainsi que la précision des cibles de trim et
de régime moteur. Les valeurs par défaut sont fondées sur le modèle de moteur sélectionné dans le menu de sélection de
modèle Engine (Moteur) Voir Section 3 – Mode ECO pour de plus amples informations.

Cruise/SmartTow Type (Type Régulateur de vitesse/SmartTow)
Les réglages Cruise/SmartTow permettent à l'opérateur de sélectionner la source des données reçues par VesselView :
GPS, RPM ou Auto. Le réglage par défaut est Auto. VesselView contrôle les données en provenance de la source de
données de vitesse sélectionnée au moyen de l'Assistant Installation.

Trim
Les paramètres de trim permettent au pilote de sélectionner quelle position de trim ou d'embase sera affichée à l'écran
VesselView. Lorsque trim est décoché dans le menu Settings (Paramètres), l'affichage de trim à l'écran est remplacé par
une boîte de données de supplémentaire.
Les paramètres de trim permettent aussi d'étalonner la plage d'affichage de trim d'un moteur ou d'une embase. VesselView
affiche une échelle graduée dans la boîte de données sélectionnée par l'utilisateur ainsi qu'un curseur gradué au bas de
l'écran. Les pourcentages de trim sont représentés par les marques de teinte gris pâle. Les pourcentages de tilt
(inclinaison) sont représentés par des marques plus foncées. La barre blanche du graphique indique la position exacte du
trim.
À l'aide de la fenêtre d'étalonnage, il est possible d'affiner les pourcentages de trim pour mieux afficher à l'écran les limites
réelles dans les champs d'état de trim.
Le point où la plage de trim coïncide avec la plage d'inclinaison est le point où le trim devient tilt (inclinaison) Ce
pourcentage de transition peut être réglé pour refléter plus précisément la position du curseur dans l'affichage de l'échelle
de trim.

EasyLink

56815



Section 4 - Configuration et étalonnages

90-8M0126149   fra  MARS 2016 Page  55

56819

Sur les bateaux dotés de jauges SC 100, les liaisons simples doivent être activées (point) sous VesselView pour permettre
la réception de données au niveau de la jauge SC 100.

EasyLink

Port, Starboard (Bâbord,
Tribord) >

Engine and Transmission (Moteur et
Transmission) >

Port or Starboard—ON—dot, OFF—no dot (Bâbord ou tribord—Marche—Point,
OFF—pas de point)

RPM sync > (Synchronisation régime
moteur).

Port or Starboard—ON—dot, OFF—no dot (Bâbord ou tribord—Marche—Point,
OFF—pas de point)

Fuel tank 1 > (Réservoir de carburant 1
>)

Port or Starboard—ON—dot, OFF—no dot (Bâbord ou tribord—Marche—Point,
OFF—pas de point)

Fuel tank 2 > (Réservoir de carburant 2
>) ON—dot, OFF—no dot (Marche—Point, OFF—pas de point)

Oil tank > (Réservoir d'huile >) ON—dot, OFF—no dot (Marche—Point, OFF—pas de point)
Fresh Water > (Eau douce >) ON—dot, OFF—no dot (Marche—Point, OFF—pas de point)
Wastewater tank (Réservoir d'eaux
usées) >

Gray tank 1, Black tank 1—ON—dot, off—no dot (Réservoir gris 1, Réservoir noir
1—ON—point, OFF—pas de point

Les paramètres EasyLink permettent d'utiliser les connecteurs des jauges reliées (Link Gauges) du faisceau de
VesselView pour transmettre des données aux jauges reliées de la barre. Quatre connexions d'instruments reliés au
faisceau VesselView sont étiquetés SYS LINK STBD (System Link tribord) et SYS LINK PORT (System Link bâbord).
Les connecteurs de liaison de données (DLC) bâbord et tribord peuvent être sélectionnés pour transmettre des données
qui parviennent de sources différentes de celles indiquées sur l'étiquette du faisceau de connexion. Cela peut être utile
lorsque des instruments similaires sont situées hors de la portée du faisceau d'extension de l'instrument femelle.

59954

Exemple de connecteurs EasyLink d'un faisceau VesselView
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Moteur et transmission
Les données de transmissions et de moteur peuvent être sélectionnées pour s'afficher sur un instrument relié au système
(SLG) compatible qui sera utilisé pour transmettre les données

RPM Synchronization (Synchronisation du régime moteur)
RPM Synchronization (Synchronisation du régime moteur) permet de régler plusieurs moteurs au même régime à l'aide du
bouton SYNC du pavé tactile CAN. Si le bateau est équipé d'un instrument relié au système SYNC, l'opérateur peut voir
l'aiguille bouger jusqu'à ce que la synchronisation soit obtenue. La position par défaut de la connexion du faisceau de
liaison est PORT (Bâbord) pour cet instrument. PORT (Bâbord) doit toujours être coché.

60226

Réservoirs
Au cours de la configuration des réservoirs, des données ont été saisies qui définissent l'emplacement, le nom et la
capacité de chacun des réservoirs. Les paramètres des instruments reliés au système permettent de sélectionner quel
faisceau de connexion transmettra les données obtenues en sélectionnant l'onglet de réservoir. Les onglets de réservoirs
avec tête de flèche indiquent que ces réservoirs ont été définis lors de la configuration des réservoirs dans le menu Vessel
settings (Paramètres du bateau) et qu'on peut leur assigner un emplacement sous EasyLink.

Préférences

56815

56820
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Le menu Preferences (Préférences) permet à l'opérateur de définir des niveaux de bips, de modifier les paramètres de
rétroéclairage, d'activer des éléments de la barre de défilement, de remplir des boîtes de données, de personnaliser des
écrans contextuels et de sélectionner des unités de mesure.
Le signe supérieur à (>) indique des options de menu supplémentaires.

Preferences (Préférences)

Buzzer (Vibreur) >

Key beeps—OFF, Quiet, Normal, or Loud (Tonalité des touches
—Désactivé, Discret, Normal ou Niveau sonore élevé —

Alarm beeps—ON—dot, OFF—no dot (Tonalités d'alarme—
Activé—point, Désactivé—pas de point) —

Backlight (Rétroéclairage) >

Level (Niveau) > Select 0%—100% (Sélectionner 0 %—100 %)

Night mode > (Mode nocturne >) ON—dot, OFF—no dot (Activé—point, Désactivé
—pas de point)

Network update > (Mise à jour du réseau >) ON—dot, OFF—no dot (Activé—point, Désactivé
—pas de point)

Local gain > (Gain local >) Input 0%—100% (Entrée 0 %—100 %)

Scroller Bar > (Barre de défilement >)

Auto-hide delay > (Délai de masquage automatique >) Select 5, 10, 15, or 20 seconds (Sélectionner 5,
10, 15 ou 20 secondes)

Item visibility > (Visibilité des éléments >)

X-Pand—ON—dot, OFF—no dot (Activé—point,
Désactivé—pas de point)
Temperatures—ON—dot, OFF—no dot
(Température—Activé—point, Désactivé—pas de
point)
Pressure—ON—dot, OFF—no dot (Pression—
Activé—point, Désactivé—pas de point)
Voltages—ON—dot, OFF—no dot (Tension—
Activé—point, Désactivé—pas de point)
Fuel—ON—dot, OFF—no dot (Carburant—Activé
—point, Désactivé—pas de point)
Tanks—ON—dot, OFF—no dot (Réservoirs—
Activé—point, Désactivé—pas de point)
Advanced—ON—dot, OFF—no dot (Paramètres
avancés——Activé—point, Désactivé—pas de
point)
Performance—ON—dot, OFF—no dot
(Performances—Activé—point, Désactivé—pas
de point)
Trim and Tabs—ON—dot, OFF—no dot (Trim et
dérives—Activé—point, Désactivé—pas de point)
Trip Log—ON—dot, OFF—no dot (Journal des
sorties—Activé—point, Désactivé—pas de point)
Navigation—ON—dot, OFF—no dot (Navigation
—Activé—point, Désactivé—pas de point)
Generator—ON—dot, OFF—no dot (Générateur
—Activé—point, Désactivé—pas de point)
ECO—ON—dot, OFF—no dot (ECO—Activé—
point, Désactivé—pas de point)
Autopilot—ON—dot, OFF—no dot (Autopilot—
Activé—point, Désactivé—pas de point)
Cruise—ON—dot, OFF—no dot (Régulateur de
vitesse—Activé—point, Désactivé—pas de point)
Troll Control—ON—dot, OFF—no dot
(Commande de pêche à la traîne—Activé—point,
Désactivé—pas de point)
SmartTow—ON—dot, OFF—no dot (SmartTow—
Activé—point, Désactivé—pas de point)

Data Boxes (Zones de données) >
REMARQUE : Les zones de données disponibles dépendent de
l'ensemble de propulsion. Sélectionner les options à afficher. —

Pop-ups >(Fenêtres contextuelles >)

Warnings > (Avertissements >) ON—dot, OFF—no dot (Activé—point, Désactivé
—pas de point)

Joystick Piloting > (Système de pilotage par manette) ON—dot, OFF—no dot (Activé—point, Désactivé
—pas de point)

Trim > ON—dot, OFF—no dot (Activé—point, Désactivé
—pas de point)

Trim pop-up time > (Durée d'affichage des fenêtres contextuelles
de trim)

Select 2, 5, or 10 seconds (Sélectionner 2, 5 ou
10 secondes)

Auto-cycle interval > (Intervalle de
cycle automatique >) Select 1, 5, or 10 seconds (Sélectionner 1, 5 ou 10 secondes) —

Units (Unités) >

Distance—nm, km, or mi (Distance—nm, km ou mi) —
Distance small—ft, m, or yd (Distance courte—ft, m ou yd) —
Speed—kn, kph, or mph (Vitesse—Kn, km/h ou mi/h) —
Wind speed—kn, kph, mph, or m/s (Vitesse du vent—Kn, km/h,
mi/h ou m/s) —
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Preferences (Préférences)
Depth—m, ft, or fa (Profondeur—m, ft ou fa) —
Altitude—m or ft (Altitude—m ou ft) —
Heading—°M or °T (Cap—°M ou °T) —
Temperature—°C or °F (Température—°C ou °F —
Volume—L or gal (Volume—l or gal) —
Economy—Distance/Volume, Volume/Distance, mpg, g/mi,
km/L, or L/100km (Économie—Distance/Volume, Volume/
Distance, mpg, g/mi, km/l, or l/100km)

—

Pressure—in. Hg, bar, psi, or kPa (Pression—in. Hg, bar, psi ou
kPa) —

Baro Pressure—in. Hg, mb, or hPa (Pression barométrique—in.
Hg, mb ou hPa) —

Vibreur
Le vibreur permet à l'utilisateur de régler le volume sonore des touches bips. Le bip est la confirmation auditive qu'une
sélection a été faite.
Il est possible d'activer / désactiver les bips d'alarme avec cette touche. Toutes les alarmes sont affichées sur l'écran
VesselView, quel que soit l'état du bip d'alarme. Les préférences en matière de bips d'alarme ne s'appliquent qu'aux
alarmes qui ne sont pas contrôlées par le système Mercury Guardian. Par exemple, une alarme de bas niveau de
carburant (LOW FUEL LEVEL)

Rétroéclairage
Les préférences en matière de rétroéclairage se règlent à partir de ce menu.
• La luminosité de l'écran se règle par incréments de 10 % dans une plage comprise entre 10 et 100 %.
• Un mode nocturne est disponible dans les environnements à faible luminosité.
• Tous les instruments et appareils (Link Gauges) reliés à VesselView s'afficheront, après mise à jour du réseau, au

pourcentage de luminosité sélectionné par l'opérateur à l'onglet Level (Niveau).
• La fonction Local Gain (Gain local) ne peut être utilisée que pour régler l'affichage de VesselView, indépendamment

d'autres indicateurs et jauges, même si la case Network Update (Mise à jour du réseau) est sélectionnée. Dans
certaines conditions d'éclairage, la luminosité de l'écran VesselView peut être trop forte pour le confort de la lecture
mais il est nécessaire de maintenir le niveau de luminosité des autres indicateurs et jauges. Suivre ces instructions
pour régler l'affichage de VesselView avec la fonction Local Gain (Gain local).
a. Sélectionner Level (Niveau) et choisir un pourcentage de luminosité.
b. Sélectionner Local Gain (Gain local) et saisir le pourcentage sélectionné à l'étape précédente ;sélectionner OK

sur le clavier.
c. Restaurer l'option Level (Niveau) à la valeur 100 %. L'écran VesselView reste assombri tandis que tous les

appareils et jauges en réseau conservent leur luminosité.
d. Pour restaurer la pleine luminosité de VesselView, sélectionner Local Gain (Gain local), saisir 100 et sélectionner

OK.
e. Sélectionner l'onglet Level (Niveau) et choisir un pourcentage quelconque autre que 100 et appuyer sur la touche

Enter (Entrée) Selectionner 100 % et le taux de 100% de luminosité de VesselView est restauré.

Barre de défilement
Les paramètres de la barre de défilement comprennent un mode de masquage automatique réglable entre 5 et 30
secondes avant que la barre ne soit réduite si aucune sélection n'est faite.
La fonction d'affichage des éléments de la barre de défilement (Scroller Bar Item visibility) affiche les éléments cochés qui
s'afficheront au menu de la barre de défilement au bas de l'écran VesselView. Les éléments de la barre de défilement sont
préselectionnés en fonction de la sélection moteur effectuée avec l'Assistant Installation (Setup Wizard), mais n'importe
quel élément de cette barre peut être activé/désactivé à tout moment.

Fenêtres de données
Les fenêtres de données affichent un maximum de trois éléments de données à l'écran.
Il est possible d'accroître le nombre de fenêtres de données de un à trois maximum, en fonction des sélections effectuées
dans le menu Settings (Paramètres). Lorsqu'une fenêtre de données est sélectionnée, elle s'affiche dans le coin supérieur
gauche de l'écran. Si l'option de fenêtres de données supplémentaires est grisée, c'est l'indication que tout l'espace
disponible est utilisé par VesselView. Pour libérer de l'espace à l'écran, suivre les instructions suivantes.
Pour activer une deuxième fenêtre de données, entrer dans le menu Settings (Paramètres) Sélectionner
Vessel>Tabs>Show (Bateau>Dérives>Afficher). Décocher l'option Show pour effacer les données de dérive affichées. Une
deuxième fenêtre de données s'affiche à la place
Pour activer une troisième fenêtre de données, entrer le menu « Settings » (Paramètres). Sélectionner
Engines>Trim>Show (Moteurs>Trim>Afficher) Décocher l'option Show (Afficher) pour effacer les données de trim de
l'écran. Cette zone d'écran sera remplacée par une troisième fenêtre de données.
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REMARQUE : Il n'est pas possible de rénitialiser les valeurs de la fenêtre de données « Fuel Used » (Carburant
consommé). « Fuel Used », affiché FULUSD, est une valeur qui continue à augmenter tant que cette fenêtre est activée.
Seule une réinitialisation générale (Master Reset) effacera les données affichées à cette fenêtre. En remplacement de la
fenêtre Fuel Used, sélectionner la fenêtre de données « Fuel Used Trip » (Carburant consommé en déplacement). La
procédure de réinitialisation est disponible à l'icône Trip Log (Journal des sorties) de la barre de défilement (Scroller Bar).
La sélection de RESET (Réinitialiser) dans la zone de données utilisateur efface toute donnée affichée à l'écran . Il est
possible de réinitialiser Fuel Used Trip (FULTRP à l'affichage) aussi souvent que souhaité au cours de la procédure.

Pop-ups (Fenêtres contextuelles)
« Pop-ups » permet à l'opérateur de déterminer quelles fenêtres contextuelles apparaîtront à l'écran. Les « Pop-ups »
(Fenêtres contextuelles) disponibles comprennent les avertissements, JoyStick Piloting (Système de pilotage par manette)
et les données de trim.
L'alerte Joystick Piloting s'affiche à la fenêtre System Status (État du système), au bas de l'écran, pour signaler à
l'opérateur qu'une fonctionnalité d'Autopilot a été activée.
La case à cocher Warnings (Avertissements) permet à l'opérateur d'afficher n'importe quel message de panne moteur, en
taille réelle, dans la zone de données sélectionnées par l'utilisateur, si ce message est coché. S'il n'est pas coché, le
message d'erreur s'affichera dans le champ d'état du système dans le coin inférieur gauche de l'écran.

Auto-Cycle Interval (Intervalle de cycle automatique)
La fonction « Auto-cycle interval » permet de déterminer le temps d'affichage des données dans le champ des données
sélectionnées par l'utilisateur, soit 1, 5 ou 10 secondes.

Unités
Le choix des unités de mesure s'effectue indépendamment, au gré de l'opérateur, à savoir : U.S. standard, métriques ou
nautiques.

Alarmes

56815

56821

« Alarms » permet au pilote de vérifier l'historique de n'importe quelle alarme, d'activer ou de désactiver une alarme
spécifique, ou d'afficher toutes les alarmes. À l'aide des boutons fléchés, mettre l'option en surbrillance et appuyer sur la
touche ENTER (Entrée) pour activer ou désactiver l'alarme.
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Alarmes

Alarms
(Alarmes) >

Alarm History
(Historique des alarmes) Affiche les alarmes existantes

REMARQUE : Voir le commentaire au bas du
tableau.

Alarm Settings >
(Configuration des
alarmes >)

REMARQUE : Ces paramètres doivent être activés pour
pouvoir recevoir des alarmes.

Shallow water—ON—dot, OFF—no dot (Eau peu
profonde—Activé—point, Désactivé—pas de point)
Deep water—ON—dot, OFF—no dot (Eau profonde—
Activé—point, Désactivé—pas de point)
Speed through water rationality fault—ON—dot, OFF—no
dot (Erreur de détermination de la vitesse en surface—
Activé—point, Désactivé—pas de point)
Fuel remaining low—ON—dot, OFF—no dot (Bas niveau
de carburant—Activé—point, Désactivé—pas de point)

Fuel Tanks > (Réservoirs de carburant >)

PORT FUEL low—ON—dot, OFF—no dot (Bas
niveau du réservoir de carburant bâbord—Activé—
point, Désactivé—pas de point)
PORT FUEL high—ON—dot, OFF—no dot (Haut
niveau du réservoir de carburant tribord—Activé—
point, Désactivé—pas de point)
STBD FUEL low—ON—dot, OFF—no dot (Bas
niveau du réservoir de carburant tribord—Activé—
point, Désactivé—pas de point)
STBD FUEL high—On—dot, Off—no dot (Haut
niveau du réservoir de carburant tribord—Activé—
point, Désactivé—pas de point)

Oil tanks > (Réservoirs d’huile >)

Oil low—ON—dot, OFF—no dot (Bas niveau du
réservoir d'huile—Activé—point, Désactivé—pas de
point)
Oil high—ON—dot, OFF—no dot (Haut niveau du
réservoir d'huile—Activé—point, Désactivé—pas de
point)

Fresh water tanks > (Réservoirs d'eau douce >)

Fresh water low—On—dot, Off—no dot (Bas niveau
du réservoir d'eau douce—Activé—point, Désactivé
—pas de point)
Fresh water high—On—dot, Off—no dot (Haut
niveau du réservoir d'eau douce—Activé—point,
Désactivé—pas de point)

Gray water tanks > (Réservoirs d'eaux grises >)

Gray water low—ON—dot, OFF—no dot (Bas niveau
du réservoir d'eaux grises—Activé—point, Désactivé
—pas de point)
Gray water high—ON—dot, OFF—no dot (Haut
niveau du réservoir d'eaux grises—Activé—point,
Désactivé—pas de point)

Black water tanks > (Réservoirs d'eaux noires >)

Black water low—ON—dot, OFF—no dot (Bas
niveau du réservoir d'eaux noires—Activé—point,
Désactivé—pas de point)
Black water high—ON—dot, OFF—no dot (Haut
niveau du réservoir d'eaux noires—Activé—point,
Désactivé—pas de point)

Live well water tanks > (Réservoirs d'eaux de viviers >)

Live well low—ON—dot, OFF—no dot (Bas niveau
du réservoir d'eau de vivier —Activé—point,
Désactivé—pas de point)
Live well high—ON—dot, OFF—no dot (Haut niveau
du réservoir d'eau de vivier —Activé—point,
Désactivé—pas de point)

Show all Helm alarms
(Afficher toutes les
alarmes de barre)

ON—dot, OFF—no dot (Activé—point, Désactivé—pas de
point)

Sous Historique des alarmes,appuyer sans relâcher sur le bouton PAGES . Une fenêtre contextuelle proposant de
réinitialiser toutes les pannes s'affiche. Sélectionner cette fenêtre et l'historique des pannes sera effacé Les données et
l'historique des pannes peuvent être sauvegardées ou transférées de VesselView.
Alarm Settings (Configuration des alarmes) permet à l'opérateur de sélectionner et de modifier les paramètres—minimums
and maximums, de déclenchement des alarmes.
L'icône Show all Helm alarms (Afficher toutes les alarmes de barre) peut être activée ou désactivée (on—dot, off—no dot /
Activé—point, Désactivé—pas de point)
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Personality File (Fichier personnalité)

56815

56822

Depuis le menu Paramètres de configuration (Personality), l'opérateur peut exporter (EXPORT) ou importer (IMPORT) la
configuration d'un bateau. Les fichiers de configuration sont utilisés par les constructeurs et les propriétaires de bateau
pour configurer toutes les préférences et tous les paramètres dans VesselView afin d'optimiser le fonctionnement des
systèmes embarqués. Le port de carte micro SD permet de transférer des fichiers vers VesselView et vice versa.
VesselView détecte quelles configurations peuvent être importées de la carte micro SD ; l'opérateur peut donc parcourir la
liste et sélectionner la configuration appropriée. Pour exporter un fichier de configuration, insérer une carte micro SD dans
VesselView.
L'option Restore (Restaurer) permet au personnel qualifié de restaurer les paramètres OEM. Un VesselView qui a été
configuré par un constructeur ou un concessionnaire contient un fichier qui est spécifique au bateau, lequel fichier peut
servir à restaurer les fichiers de configuration du bateau considéré. Contacter un concessionnaire agréé pour obtenir cette
option, le cas échéant.

Personality File (Fichier de configuration)

Personality File > (Fichier de configuration >)

Export > (Exportation >) To new file... (Vers nouveau fichier...)
Import > (Importer >) Le fichier approprié doit figurer dans la carte SD

Restore > (Restaurer >) REMARQUE : À l'usage exclusif d'un technicien compétent.

Export
L'exportation d'un fichier de configuration s'effectue en sélectionnant l'option Export (Exportation). Un écran s'affiche
demandant l'exportation de la configuration. Un fichier est ainsi créé qui contient tous les paramètres et préférences de
VesselView. Ce fichier peut être importé, le cas échéant, pour rétablir la configuration de VesselView.

Import (Importer)
Pour importer un fichier de configuration, vérifier qu'une carte SD a bien été insérée dans VesselView. Sélectionner Import
(Importer) et sélectionner la configuration appropriée. Toutes les configurations sur la carter SD doivent se situer au niveau
racine et non pas dans l'un des dossiers. L'importation d'un fichier de configuration peut aussi s'effectuer au cours de la
procédure de l'Assistant Installation.
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Restore (Restaurer)
L'option Restore (Restaurer) permet au personnel qualifié de restaurer les paramètres OEM. Un VesselView qui a été
configuré par un constructeur ou un concessionnaire contient un fichier qui est spécifique au bateau, lequel fichier peut
servir à restaurer les fichiers de configuration du bateau considéré. Contacter un concessionnaire agréé pour obtenir cette
option, le cas échéant.
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Avertissement – Pannes et alarmes
Tous les avertissements Mercury – les pannes et les alarmes sont affichées, quel que soit l'écran affiché au moment de
leur déclenchement. Lorsqu'une alarme est activée, le texte d'avertissement et l'icône s'affiche dans le champ d'état du
système. Les pannes s'affichent en plein écran avec un texte court, un texte long et un texte relatif à l'action.
• Lorsqu'une panne se produit :

a. Le champ d'état du système devient rouge et affiche une icône et un texte d'avertissement.

52101

b. Les pannes de carburant et de profondeur comportent des options supplémentaires décrites dans Alarme de
carburant critique et Alarme de profondeur.

c. Une panne de niveau 3 (trim, navigation, ECO, carburant) peut être activée ou désactivée par le pilote dans le
menu Settings (Paramètres). Par défaut, elle est activée. Si la panne est désactivée dans le menu Settings
(Paramètres), les pannes s'affichent uniquement dans le champ d'état du système.

d. Toutes les pannes de niveau 4 (Guardian) sont toujours affichées, quelles que soient les sélections effectuées
dans le menu Settings (Paramètres).

e. Si la panne concerne le contrôle des émissions, l'icône du moteur s'affiche dans le champ d'état du système.
• Lorsque le pilote sélectionne une panne dans une zone de données sélectionnées par l'utilisateur :

a. Le titre de la panne et l'icône d'avertissement sont affichés en haut de la zone contextuelle.
b. Un texte court et l'emplacement de la panne (moteur) sont affichés sous le titre.
c. En présence de plusieurs pannes, appuyer sur le bouton PAGES pour accéder aux pannes. Naviguer vers

chaque panne à l'aide des boutons fléchés.

a - Titre de la panne avec icône d'avertissement
b - Texte court ou texte de référence
c - Emplacement de la panne du moteur
d - Texte relatif à l'action
e - Nombre de pannes

Alarme de carburant critique
L'alarme de carburant est gérée par VesselView, selon la séquence Settings>Alarms>AlarmSettings>
(Paramètres>Alarmes>Paramètres d'alarme>) et non pas par le module ECM/PCM du moteur.
• Les paramètres de notification et les alertes de niveau de carburant peuvent être configurés dans le menu Settings

(Paramètres).
• Si le pilote a sélectionné Fuel (Carburant) comme champ de données constantes à l'emplacement n° 2 (voir Screen

Display Locations and Descriptions [Emplacements et descriptions de l'écran]),puis le champ de données relatives au
carburant affiche l'avertissement.

• L'icône d'avertissement remplace l'icône de carburant et le champ de données reste en rouge.
• Si Fuel (Carburant) n'a pas été sélectionné par le pilote comme champ de données constantes (emplacement n° 2),

mais qu'il est actif sous forme d'avertissement de panne, le champ d'état du système affiche le message FUEL
(Carburant) sur fond rouge.

• Le pilote peut également sélectionner l'avertissement relatif au carburant sous forme de fenêtre contextuelle de zone
de données sélectionnées par l'utilisateur dans le menu Settings (Paramètres). Appuyer sur la touche ENTER (Entrée)
pour réduire l'alarme de niveau de carburant. La panne est toujours affichée à un emplacement ou un autre, selon la
configuration d'écran.

Alarme de profondeur
L'alarme de profondeur est gérée par VesselView, non par le module ECM/PCM du moteur.

51619
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• Les paramètres de notification et les niveaux d'alerte de profondeur peuvent être configurés dans le menu Settings
(Paramètres).

• Si le pilote a configuré l'affichage de la profondeur comme champ de données constantes à l'emplacement n° 1, voir
Emplacements et descriptions de l'écran,puis le champ de données relatives à la profondeur affiche l'avertissement.

• L'icône d'avertissement remplace l'icône de profondeur et le fond du champ de données reste rouge.
• Si DEPTH (Profondeur) n'est pas sélectionné comme champ de données constantes (emplacement n° 1), mais est

actif sous forme d'avertissement de panne, le champ d'état du système affiche le message DEPTH (Profondeur) sur
fond rouge.

• Le pilote peut également afficher l'avertissement relatif à la profondeur sous forme de fenêtre contextuelle de zone de
données sélectionnées par l'utilisateur dans le menu Settings (Paramètres). Appuyer sur X pour réduire l'alarme de
profondeur. La panne reste affichée à l'un de deux emplacements, en fonction de la configuration d'écran.
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